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Abbreviations & Acronyms 
 

Abbreviations 

An abbreviation is a shortened form of a word or phrase. Both acronyms and 
abbreviations save time and words, but they can confuse the reader who is not 
familiar with them. 

Rules 

 Whenever possible, avoid abbreviations; type the entire word. 
 

 Do not use Latin abbreviations (such as i.e., e.g., et al., etc., and N.B.); 
use the English equivalents instead. The abbreviations a.m. and p.m. are 
exceptions. 
 

Correct 
 
On the cover sheet write the type of foreclosure (for example, reinstated, REO, or 
cancel). 
 
Incorrect 
 
On the cover sheet write the type of foreclosure (e.g., reinstated, REO, or cancel). 
 

Acronyms 

An acronym is a word formed from the first (or first few) letters of a series of words, 
such as FAC (First American Corporation). 

Rules 

 Avoid starting sentences with acronyms. 

Correct 

Associates complete Job Performance Discussion (JPD) forms before meeting with 
their managers. 

An automated valuation model (AVM) is ordered automatically for loans that meet 
certain criteria. 

 The spelled-out versions of acronyms are not automatically shown with initial 
capital letters for each word. If the words are proper names, initial capitals 
are appropriate. Many acronyms represent common terms that do not require 
capitalization when spelled out, such as "annual percentage rate" for APR. 
See the Acronyms for the spelled-out versions of many acronyms used at 
Ameriquest. 
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 Do not spell out acronyms in headers or in the RoboHelp table of contents. 



Plurals of Acronyms 

If acronyms are used, the plural form is created by simply adding an s; do not use 's 
(apostrophe + s). 

Correct 

The Insured AVM Specialty Group tracks all loans using Insured AVMs. 

Incorrect 

The Insured AVM Specialty Group tracks all loans using Insured AVM's. 

Acronyms as Possessives 

 To form a possessive of an acronym, use an 's (apostrophe + s); precede 
acronym with the word the. 

 For acronyms of names, such as companies or departments, do not use the 
before the acronym. 

Correct 

Today is the CFO's birthday. 

These guides are some of TW's products. 

Incorrect 

Today is CFO's birthday. 

These guides are some of the TW's products. 

 

 
Capitalization 

About Capitalization 

Overview 

The trend over the past 50 years has been to reduce capitalization in documents. 
This topic lists the basic rules for capitalization. See related topics for the style 
guidelines that have been selected for particular situations within title and mortgage 
companies. 

Rules 

 Capitalize the following: 
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 The first word of a sentence 



 The first word of items in ordered lists or unordered lists 
 Proper nouns and proper adjectives 
 The first, last, and all major words in titles and subtitles of works such 

as books, articles, songs, and online documents 
 The days of the week, months, and holidays 
 The first word of a quoted sentence, but not a quoted phrase 
 Shortened forms of capitalized words 
 Acronyms for departments and agencies of the government, other 

organizations, and the call letters of radio and television stations 

Examples 

Fair Housing Act 

U.S. Department of Housing and Urban Development 

Monday, February, Columbus Day 

FHA, HUD, KFWB 

 Do not capitalize the following: 
 

 Common nouns 
 Articles unless an article is the first word in the title 
 Coordinating conjunctions 
 Prepositions of four or fewer letters 

 Do not start a sentence with a term that must be spelled all lowercase. 
 Avoid starting a sentence with an acronym. 
 Do not use all uppercase letters for emphasis; use only for acronyms. 

Capitalization and Punctuation 

Overview  

In addition to the rules described in the  
Capitalization section of this manual, note these capitalization rules that apply to 
words following certain marks of punctuation. 

Rules 

 Always capitalize the first word in a hyphenated word in a title. Capitalize the 
second word only if it is a noun or an adjective or is as important as the first 
word. 

Correct 

State-Specific Lending Requirements 

Ordering Sale-Date Inspections 
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Applying Stage Make-up 

javascript:void(0);
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Incorrect 

State-specific Lending Requirements 

Ordering Sale-date Inspections 

Applying Stage Make-Up 

 A sentence that is set off within another sentence by dashes or 
parentheses should not be capitalized. 

 A sentence within parentheses that stands by itself is capitalized. 

 Do not capitalize the word following a colon unless the word is a proper noun 
or the text following the colon is a complete sentence. 

 Do not capitalize the word following an em dash unless it is a proper noun, 
even if the text following the em dash is a complete sentence. 

Correct 

Several criteria were used: The criteria were service, stability and knowledge. 
Several criteria were used: service, stability and knowledge. 

Incorrect 

Several criteria were used—the criteria were service, stability and knowledge. 
Several criteria were used: Service, stability and knowledge. 

  
Names of Documents, Forms, and Reports 

Rules 

 In general capitalize the names of documents, forms, and reports. Try to 
obtain copies of such items that you must refer to, so you can determine the 
exact name to use. 

 Do not capitalize the words "form," "request," or "report" unless the word is 
actually part of the name. 

 If the name of a document, form, or report appears in all uppercase letters, 
use the same name in P&P text, but use uppercase and lowercase letters 
instead. 

Correct 
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Agreement Concerning Non-Refundability of Advance Fees 
Consumer Caution and Home Ownership Counseling Notice 
Notice of Intention to Foreclose 
Notice to Inquirers and Loan Applicants 
Notice to Purchaser-Mortgager form 
Personnel Change Request (PCR) 
Trial Balance Report (P165) 



Note: Although the word "Non-Refundability" (in Agreement Concerning Non-
Refundability of Advance Fees) does not need a hyphen, in your document use the 
name as it appears on the form. If you are able to change the name of an internal 
form to eliminate incorrect hyphens or other punctuation, please do so. 

Incorrect 

NOTICE TO PURCHASER-MORTGAGER 

Notice to Purchaser-Mortgager Form 

 
Names of Online Guides 

Rules 

 Use initial caps for the names of online guides produced by Technical Writers. 
 Do not use boldface text for these names unless the name appears in a 

heading or subheading or as a link. 

Correct 

DTS 2.0 User Manual 
Data Trace Style Guide 

 
 
Names of Software and Systems 
 
Overview 
 
As with vendor names, take care to type software and system names correctly. 

Rules 

 When referring to the names of computer systems, try to follow the naming 
conventions of the vendor or, in the case of systems developed in-house, the 
developers. 

 A list of system names appears in this topic. Add these names to the 
RoboHelp (any applicable editing tool) dictionary if you want to prevent red 
wavy lines from appearing under them on-screen. 

System Names 
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Data Trace System 
Data Tree 
Fidelity's Mortgage Servicing Package (MSP) 
Fidelity's Mortgage Servicing Package Director 
ImageVision 
Microsoft PowerPoint 
Microsoft Visual SourceSafe (VSS) 
Mortgage Servicing Package (MSP) 



TeleTitle 
Tracker 
Visual SourceSafe (VSS) 

 
 
Names of Vendors 

Rules 

When referring to vendors or business partners, try to follow the naming conventions 
of the vendor. Check the vendor's Web site for guidance. 

Examples 

Dimont & Associates 
FedEx (no spaces) 
Jasc Software, Inc. 
JPMorgan Chase 
 

 
Names of Web Sites, Pages, Options 
 
Overview 
 
This topic describes capitalization and the use of boldfaced type for names of intranet 
and Internet sites, pages, and options. 

Rules 

In general, use initial caps and boldfaced type for the names of Web sites and Web 
pages. Follow this same general guideline for the names of Web page elements that 
users can click or select, such as menus, tabs, and buttons. 

Correct 

Go to Title Services, and click Subdivided. 
Print your First American paycheck stub from the eWorkforce Web site. 
Search for the term using Google. 
 

 
Publishing Content 
 

Generating Web Help 
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The WebHelp folder contains the HTML files to be copied to the staging folder, and 
eventually published to production. 



Note: The procedures in this topic describe the settings to use when generating 
WebHelp for the first time. For projects in which WebHelp has already been 
generated, the correct settings already exist and do not need to be reentered. 

Procedure 

To generate WebHelp (for the first time only): 

1. On the File menu, click Generate, and then click WebHelp.  
2. In the WebHelp General window, select the correct output folder; under 

Select Skin, make sure that Traditional Style – no skin is selected. 
 

 

3. Click Next.  
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4. In the WebHelp Navigation window, under Tabs, select TOC and Search; 
if Index is selected, clear it. 

javascript:kadovTextPopup(this)


 

 

5. Under Preferred Format, click DHTML > Java Applet > Pure HTML. 
6. Under Optimize Speed For, click Web Site. 
7. Select Automatically Sync TOC. 
8. Click Next. The WebHelp Options window opens. 
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10. Under Location, click Top Left; under Style, click Image. 
11. Under In-Topic Navigation Bar Element, make sure the Show/Hide 

Navigation Pane check box is selected. 
12. Under Detail: Show/Hide Navigation Pane, make sure the custom Show 

Contents and Hide Contents buttons are displayed. 
13. Click Finish. 

 

Printing RoboHelp Reports 

Use RoboHelp reports to identify broken links, unused files, and other information 
when preparing to publish a project to improve project quality. 

Procedure 

 
To print a RoboHelp report: 

1. On the Tools menu, point to Reports. 

 

2. Click a report name, such as Broken Links, Unused Files, or External 
Topics, to generate a report. 
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Publishing Content 

Overview 

Publishing content in RoboHelp is done by publishing your project. Projects contain 
single source layouts which allow you to publish output files to a specific location. 
This can be to your local hard drive, a company intranet, the Internet, or to a 
network drive.  

Single source layouts act as templates for different versions of your project. 
Typically, when you generate a different version of your project, different settings 
are used for the output (such as skins, conditional build tags, or navigational 
buttons). You can save these settings in single source layouts and publish whenever 
needed. 

Procedure 

To Publish Content: 

1. Define a publishing destination for your WebHelp. 
2. Click the Project tab to display the Project Manager. 
3. Expand the Single Source Layouts folder. 
4. Right-click the layout and select Publish. If you are prompted to generate 

and want to include your changes when you publish, click Yes. If not, click 
No. 
When the process is complete, a dialog displays statistics about the publishing 
process and a list of files published. 

5. Click Close. 

Note: You may need to work with network administrators or other writers to 
determine publishing destinations and version control. 

 
Troubleshooting RoboHelp Links 

If a RoboHelp project contains references that no longer work, follow this procedure 
to identify where they are. 

Procedure 

 
To troubleshoot RoboHelp links: 

1. Click the Project tab and then click the plus sign for the Broken Links 
folder. 

2. Right-click a broken topic, and click Show Topic References. All of the 
references to the topic are listed, so you can investigate the cause of the 
broken link. 
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Topic References Window 



Use the Topic References window log to look up references for topics in a project. 
It indicates where references originate so they can be modified or removed. 

Topic: Displays the name of the selected topic. 

References: Identifies all references to the topic. References include books and 
pages in the table of contents, topic links and keywords. 

Edit: Tracks the origins of the reference. Book and page properties are displayed in 
their respective dialogs and links (jumps) open the topics in the WYSIWYG Editor. 
Keywords cannot be tracked from here. 

Delete: Removes the selected table of contents entry from the table of contents. 
Links can only be removed by editing the topic in the WYSIWYG Editor. Keywords 
cannot be removed from here. 

Restore: Restores HTML file references. References to non-HTML files cannot be 
restored. 

The following table illustrates the link icons in RoboHelp: 

 
 

Visual SourceSafe (VSS) 

Microsoft Visual SourceSafe (VSS) is a centralized file management system that 
enables multiple information designers to gain access to and modify files and folders. 
A folder on each information designer's personal computer hard drive is linked to 
VSS. 

Rules 

 Information designers check files in and out of VSS as needed. 
 Information designers check files out of VSS to modify or correct them. 

Checking files out prevents others from working on the same files 
simultaneously. 

 After completing work on the files, information designers check the files back 
in to VSS, where they can then be opened by others as needed. 

Note: When checking files in, users are prompted to type a description and 
publishing date. 

VSS Explorer Window 
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Front Matter 
 

Discontinued Practices 

 
Overview 
 
This topic describes style and naming conventions that have been discontinued. You 
might encounter instances of these old conventions in existing Information Design 
RoboHelp projects. In most cases, you should change the old style to the new style. 
Check with your team leader if you have questions. 
 
2007 
 
Correct  
 
August 9, 2007 (see Dates) 
 
Incorrect 
 
XX/XX/07  
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Style Guide Sections 

Overview 

A style guide is essential in a writing group to ensure "order and consistency on a 
language that has boundless possibilities." 

The Standards and Style Guide has the following major sections: 

Section Contains rules for 
Naming and Format Conventions Naming topic titles, files, and images, 

and conventions for using boldfaced text 
and underlining 

Procedure Writing Writing and formatting procedures 
Review and Approval Process Obtaining reviews and approvals of 

RoboHelp projects 
Content Publication Process Publishing RoboHelp projects 
Grammar and Usage Writing with correct grammar and usage 
Hyphenation and Compound Words Hyphenating words, forming compound 

words, and using prefixes correctly 
Indexing Creating indexes in Data Trace 

information products 
Lists Using ordered and unordered lists and 

related devices 
Misused and Easily Confused Words 

 

Using words in English that are often 
misused, misspelled, or confused with 
other words and words for which specific 
IDD style decisions have been made 

Numbers Using numbers and numerals, including 
general rules, units of measure, 
percentages and fractions, ranges of 
numbers, dates, times, and telephone 
numbers 

Punctuation Using various marks of punctuation 
Style for Windows-based Software 
Documentation 

Describing Windows-based software in 
procedures 

Symbols Using symbols, copyrighted works, 
trademarks, and service marks 

Tables Creating table formats and handling 
certain content, capitalization, and 
punctuation issues in tables 
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Recommended References 

Overview 

This topic describes recommended reference books for writers in the Information 
Design Department. 

Garner, Bryan A. A Dictionary of Modern American Usage. New York: Oxford 
University Press, 1998. 

Hodges, John C. Harbrace College Handbook: With 1998 MLA Style Manual 
Updates, 13th ed. New York: International Thomson Publishing, 1998. 

Microsoft Manual of Style for Technical Publications, 3rd ed. Redmond, WA: 
Microsoft Press, 2004. 

Mortgage Banking Terms: A Working Glossary, 9th ed. Washington: Mortgage 
Bankers Association of America, 2002. 

Mulvany, Nancy. Indexing Books. Chicago: University of Chicago Press, 1994. 

Random House Dictionary of the English Language, 2nd ed. unabridged. New 
York: Random House, 1987. 

Random House Webster's Unabridged Dictionary, 2nd ed. New York: Random 
House, 2001. 

Strunk, W., Jr. and E.B. White. The Elements of Style, 4th ed. Boston: Allyn and 
Bacon, 2000. 

The Chicago Manual of Style, 15th ed. Chicago: University of Chicago Press, 2003. 

The Little, Brown Handbook, 9th ed. New York: Pearson Education, 2004. 

The New York Public Library Writer's Guide to Style and Usage. New York: 
HarperCollins, 1994. 

Wellisch, Hans H. Indexing from A to Z. 2nd ed. New York: H.W. Wilson, 1995. 

Williams, Robin. The Non-Designer's Design Book: Design and Typographic 
Principles for the Visual Novice, 2nd ed. Berkeley: Peachpit Press, 2003. 

Words into Type. Based on studies by Marjorie E. Skillin, Robert M. Gay, and other 
authorities. 3rd ed. Englewood Cliffs, NJ: Prentice Hall, 1974. 
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Requesting Changes to This Guide 

 
Procedure 
 
Procedure 

  
To request a change to this guide: To request a change to this guide: 

1. Send an email message to the Technical Writer that is currently maintaining 
the Style Guide. 

1. Send an email message to the Technical Writer that is currently maintaining 
the Style Guide. 

2. Please include the following information in the message: 2. Please include the following information in the message: 

 The section of the guide to which the change applies   The section of the guide to which the change applies  
 A description of the requested change  A description of the requested change 
 Any relevant background information  Any relevant background information 
 Your name and extension  Your name and extension 

  
 
Grammar and Usage 
 

Jargon 

 
Rule 

Avoid jargon, buzzwords, and cliches; they can be confusing to some, and do not 
add value to a document. 

Correct 

Every two weeks, the executive committee meets with the subject matter 
experts. 
The CEO hopes to increase business in the future. 

Incorrect 

Every two weeks, the executive committee interfaces with the subject matter 
experts. 
The CEO hopes to grow the business in the future. 

 
Nouns 

 
Rules 

 Do not turn verbs into nouns or create verbs from nouns. 
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Correct 



Send copies of the agreement and cover letter to the borrower using FedEx. 

Incorrect 

FedEx the copies of the agreement and cover letter to the borrower. 

 Use concrete nouns and active verbs to express the meaning of a sentence. 

Correct 

Word enables the user to find a term in the document and replace it with 
another. 
They can reuse this material in the next release. 
They can use money as leverage in the negotiations. 
The First American Title Corporation maintains its headquarters in California. 

Incorrect 

Word enables the user to do a find-and-replace in the document. 
They can leverage this material for the next release. 
The First American Title Corporation is headquartered in California. 

 
Person 

Person in grammar refers to the distinction among the person talking (first person), 
the person spoken to (second person), and the person, object, or concept being 
talked about (third person). 
 

Rule 

 
Keep a sentence or related sentences consistent in person. 
 

Plurals 

 

Rules 

 Use 's to form a plural in only two instances: 

 For the plural form of letters of the alphabet 
 For the plural form of a word used to refer to the word itself. 

Correct 

He tends to put two o's in the word lose. 
You have used too many but's in this sentence. 
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 Form the plural of an acronym by adding an s with no apostrophe. 



Correct 

CPUs 
CEOs 
DBMSs 

Incorrect 

CPU's 
CEO's (possessive form of singular CEO) 

 Form the plural of a single letter by adding an apostrophe and an s. 

Correct 

x’s 

Incorrect 

xs 

 Form the plural of a number by adding an s with no apostrophe. 

Correct 

486s 
1960s 
W-2s 

Incorrect 

486's 

 Do not use "parenthetical plurals" such as "address(es)." See Parentheses 

Possessives 

 

Rules 

 Form the possessive of singular nouns and acronyms by adding an 
apostrophe and an s. This rule applies even if the noun or abbreviation ends 
in s. 
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Correct 

the manual’s search capabilities 
the index’s structure 
Brooks's Law 

 Form the possessive of plural nouns that end in s by adding only an 
apostrophe. 

Correct 

The users' suggestions 
The girls' locker room 
the articles' links 

 Form the possessive of plural nouns that do not end in s by adding an 
apostrophe and an s. 

Correct 

a children's encyclopedia 
the women's dresses 

 In compound words, make only the last word possessive. 

Correct 

Father-in-law's house (singular possessive) 
Mothers-in-law's birthdays (plural possessive) 

 In nouns of joint possession, make only the last noun possessive; in nouns of 
individual possession, make both nouns possessive. 

 

Correct 

John and Paul's office (joint possession) 
John's and Paul's offices (individual possession) 

 It is acceptable to form the possessive of acronyms, but avoid it if possible if 
the acronym does not refer to people or companies. Either use the company 
name with no ownership or use an of phrase or similar rewrite. 

Correct 

An OEM's products 
The products of OEMs 
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 Do not use possessives for product or feature names. 



 

Correct 

The Windows interface 
Microsoft Word templates, or the templates in Microsoft Word 
The dictionary in the spell checker 
The Send command on the File menu 

Incorrect 

Windows’s interface 
Microsoft Word’s templates 
the spell checker’s dictionary 
the File menu’s Send command 

 

Possessives for Company and Organization Names 

 It is acceptable to form the possessive of company names. 

Correct 

The First American Title Corporation’s benefits program 

 Form the possessive of a company or organization name by adding an 's if 
the name does not end in an s. If the name ends in a s, only an apostrophe is 
added. 

Correct 

The Bank of Virginia's trust department 

 When referring to a department that is part of another business unit, use the 
possessive form of the business unit. 

 Use the possessive form when referring to borrowers or associates. 

 If a possessive results in an awkward sentence, rewrite the sentence. 

Correct 

As an employee of First American Title Corporation, it is important that you 
conduct business with your fellow workers, customers, and suppliers with 
honesty and integrity. 
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Incorrect 



As an employee of First American Title Corporation, it is important that you 
conduct business with your fellow workers, customers, and suppliers with 
honesty and integrity. 

Pronoun and Antecedent Agreement 

 

Rules 

 As a rule, a pronoun and its antecedent (the word the pronoun refers to) 
agree in number. 

Correct 

Singular: An author may enjoy autographing his books. 
Plural: Many authors enjoy autographing their books. 

 As a rule, use a singular pronoun to refer to such antecedents as each, either, 
neither, one, anyone, everybody, a person. 

Correct 

Each person has his day in court. 

Incorrect 

Each person has their day in court. 

 The correct pronouns to use when referring to an organization is "it" and "its," 
not "they" or "their." 

Correct 

The Risk Assessment Department recently changed its name to the Appraisal 
Department. 

Incorrect 

The Risk Assessment Department recently changed their name to the 
Appraisal Department. 

 This and that are singular and must be used to modify singular nouns. 
These and those are plural and must be used to modify plural nouns. 

Correct 

I don't like this kind of book. [or these kinds of books] 
She prefers those types of pencils. [or that type of pencil] 
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Incorrect 



I don't like these kind of books. 
She prefers those type of pencils. 

Smothered Verbs 

Overview 
 
In business writing, nouns are used in many situations where a verb would be 
shorter and easier to read. Look at the examples of "smothered verbs" in this topic, 
and try to avoid them. 
 

Rules 

 
When you see a “smothered verb” 
(noun form) 

Use an active verb instead 

make a choice 
make a decision 
make a recommendation 

choose 
decide 
recommend 

take into consideration consider 
take notice of notice 
to conduct an investigation Investigate 
to give assistance help 
 
 

Subject and Verb Agreement 

 

Rules 

 A singular subject requires a singular verb, and a plural subject takes a plural 
verb. 

Singular: The baby in the stroller looks healthy. [baby looks] 

Plural: The babies in the stroller look healthy. [babies look] 

 Collective nouns and phrases denoting a fixed quantity take a singular verb 
when they refer to the group as a unit and take a plural verb when they refer 
to individuals or parts of the group. (The subjects of the sentences below are 
underlined.) 

Singular (regarded as a unit) 

The number of errors found was surprising. 
My family has its traditions. 
The couple was scheduled to arrive on Sunday. 
Two-thirds of the fund-raising goal has been met. 
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Plural (regarded as individuals or parts) 

A number of errors were discussed. 
The family are all attending different churches. 
A couple of cups of coffee invigorate me. 
Two-thirds of the cookies have been eaten. 

Note: With "a number of," or "a total of," use a plural verb. With "the number of," or 
"the total of," use a singular verb. 

 

Tense 

 

Rules 

 
Present Tense 

 Use the present tense wherever possible. Hypotheses, principles, theories, 
facts and other general truths are expressed in the present tense. 

 Avoid using the conditional could or would and invoking the future tense 
needlessly, because these uses add an unnecessary sense of indefiniteness to 
a statement.  

Past Tense 

 Use the past tense to describe results and outcomes. Research reports are 
written in the past tense because they describe work completed in the past. 

Future Tense 

 Avoid using the future tense except where appropriate; for example, to 
describe an upcoming event. 

 
Tone of Documentation 

Overview 
 
The tone or writing style of the online documentation should be in general English. 
It falls in the middle of the spectrum ranging from informal to formal English. 
General English comprises plain, straightforward language, which communicates 
more effectively than complex language. 
 
General English 
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General English follows standard grammatical conventions. Most sentences are 
simple or compound; seldom are sentences longer than 25 words. Complex and 



compound-complex sentences appear infrequently. The vocabulary favors common 
straightforward words rather than more obscure words or nominalizations. (A 
nominalization is a noun formed from a verb, used in a phrase such as make 
reference to… rather than refer to). 

General English example 

Some people who browse Web pages turn off the display of graphics and 
videos so they can browse the World Wide Web more quickly. 

Formal English 

Formal English uses more long complex sentences and complete grammatical 
constructions. Passive voice appears often, as to technical terms and 
nominalizations. Sometimes a writer can lose track of correct grammar (for example, 
subject-verb agreement) in convoluted formal English sentences. 

Formal English example 

Certain individuals who browse through World Wide Web pages turn off the 
display of multimedia such as graphics and videos, which enables them to 
navigate through the Web more expediently. 

Informal English 

Informal English is breezy and journalistic. It’s marked by short sentences and 
contractions, and often directly addresses the user. Some grammatical constructions 
may not be complete. Some attempts to be informal can sound condescending or 
unprofessional. 

Informal English example 

You can turn off graphics to surf the Web faster. 

 
Voice 

Rules 

 Whenever possible, use the active voice, in which action is expressed directly; 
the subject is doing the acting. 

 Avoid the passive voice except when necessary to avoid a wordy or awkward 
construction. 

 Use the active voice for column headings in tables that list user actions. 

Active 

The consultant directed the activity. 

Passive 
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The activity was directed by the consultant. 



 

Wordiness 

Overview 
 
Many procedures and other topics suffer from wordiness. Review your work, and try 
to trim unnecessary words. The following table lists common wordy expressions 
(especially those in boldfaced type) and shorter versions. 
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Reduce these To these 
a certain length of time a certain time 
advance planning planning 
after the conclusion of after 
am (is, are) going to shall, will 
are (am) of the opinion believe 
as a result of because 
at all times always 
at the present time 
at this point in time 

now 

before long soon 
both alike both 
by means of by 
by the time when 
come in contact with meet 
destroyed by fire burned 
due to the fact that because, due to, since 
during the month of May in May 
during the time that while 
or the amount of for 
for the purpose of for 
for the reason that because 
has the capability of working can work 
in accordance with by 
in as much as since 
in case if 
in connection with with 
in lieu of instead 
in order to to 
in regard to about 
in so far as because, since, as 
in the event that if 
in the month of May in May 
in the nature of like 
in this day and age today 
in view of the fact that since 
it has come to our attention that (begin with the word following that) 
it is interesting to note that (begin with the word following that) 
it should be noted that (begin with the word following that) 
I would appreciate it if please 
of an indefinite nature indefinite 
of great importance important 



on a timely basis fast 
on a (weekly, monthly, yearly) basis weekly, monthly, or yearly 
on condition that if 
one of the purposes (reasons) one purpose (reason) 
prior to before 
provided that if 
the length of five yards five yards or five yards long 
the necessary funds money 
with the exception of except 
until such time as until 
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Largely taken from Shaw, Harry. Dictionary of Problem Words and Expressions. 
New York: McGraw-Hill Book Company, 1975. 



 
 
Hyphenations and Compounds 
 

Hyphens 

Overview 

 Use a hyphen when compound adjectives come before the noun they modify. 

Correct 

third-party authorization 
free-form text 
pop-up window 

Owner-occupied properties are preferred. 

 Compound adjectives that are commonly used do not need a hyphen, such as 
real estate agent and first class mail. 

 Some compound modifiers are never hyphenated, such as those with an 
adverb ending in ly and those with comparative or superlative forms. 

Correct 

swiftly moving water [adverb ending in ly] 
openly hostile attitude [adverb ending in ly] 
the most expensive house on the block [superlative] 

 Hyphenate two words that precede and modify a noun as a unit if the two 
modifiers are a number or single letter and a noun or participle. 

Correct 

80-column text card 
8-point font 

Incorrect 

80 column text card 
8 point font 

 A series of compound words in a sentence that share the same base word can 
be shortened by the use of suspended hyphens. 

Correct 
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Fixed-rate loans are available for 10-, 15-, and 30-year terms. 

javascript:void(0);
javascript:void(0);


 In Loan Origination/Loan Operations documentation, do not capitalize or 
hyphenate approval levels. 

Correct 

A level 4 approval is required to remove the stipulation. 

Incorrect 

A Level-4 approval is required to remove the stipulation. 

Guideline 

 When documenting a screen element that is hyphenated incorrectly, follow 
the spelling used in the interface only when referring to the screen element. 
At all other times, apply the standard rules of hyphenation. 

Correct 

Click the Pre-Funding check box to initiate the prefunding process. 

 
Use of Hyphens with Prefixes 

Overview 
 
Consult a recently published dictionary to determine the correct spelling of a word, 
but also be aware that DataTrace has established style guidelines for some words 
that can be spelled correctly using alternative forms. 
 

Rules 

 Only two prefixes are usually hyphenated: self- and quasi-. 
 The following prefixes and combining forms are printed solid (without a 

hyphen) unless (1) they are combined with a capitalized word or (2) there is 
a possibility of two meanings or mispronunciation ( for example, un-ionized 
and unionized, re-cover and recover, multiply and multi-ply). Also, a 
hyphen is sometimes used if the combination results in a double identical 
vowel (particularly two i's) and is always used if it results in a triple 
consonant; check a current dictionary to be sure. 
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Prefixes without Hyphens 
after inter post 
ante intra pre 
anti intro pro 
bi iso pseudo 
by macro re 
co meso semi 
contra micro step 
de mis sub 



Prefixes without Hyphens 
demi mono super 
extra multi trans 
fore neo tri 
hyper non ultra 
hypo off un 
in out under 
infra over  

 
 
Correct 

multicolumn table 
nonborrowing spouse 
nonsufficient funds 
postfunding stipulation 
preapproved loan 
pre-Columbian art (The base word is a proper name, so a hyphen is needed.) 
refund (to return money), but re-fund (to fund again) 
subreport 
uninstall 

Incorrect 

multi-column table 
non-borrowing spouse 
non-sufficient funds 
post-funding stipulation 
pre-approved loan 
preColumbian art (http://en.wikipedia.org/wiki/Pre-Columbian) 
re-financing 
sub-report 
un-install 

 Hyphens are not needed in foreign phrases used as modifiers unless the 
phrase is hyphenated in the original language; laissez-faire is one of the few 
exceptions. Many of these phrases are Anglicized Latin words—ad hoc, bona 
fide, ex officio, and per capita. 

Correct 

ad hoc reports 

Incorrect 

ad-hoc reports 
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Indexing 
 

About Indexing 

Overview 
 
This topic describes basic standards for indexes in Data Trace applications. 

Rules 

 Use lowercase text for main headings and subheadings unless they are proper 
names. 

 Create indented, rather than run-in or paragraph-style indexes. 
 Use no more than two levels of subentries. 
 Avoid the use of leading prepositions and articles in subentries. 
 Place See and See also references at the bottom of an index entry, rather 

than at the top (when using software that allows you to control the placement 
of cross-references). 

Guidelines 

For indexing style guidelines not addressed by this topic, see the "Indexes" chapter 
in The Chicago Manual of Style, 15th edition (see Recommended References). 

 
 
Lists 
 

About Lists 

Overview 
 
The following types of lists are used in Data Trace documentation: 

 Ordered lists 
 Unordered lists 
 Multicolumn lists 

Note: The definition list <DL> and definition term <DT> HTML tags are not 
supported in RoboHelp; therefore, these tags are not used by Data Trace. If your 
topics require a list of terms and definitions, refer to the Definition Lists topic for 
rules on style and formatting. 

Rules 

 Use numbers or letters for ordered list items. 
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 Use bullets for unordered list items. 
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 Capitalize the first word of each list item in an ordered or unordered list 
whether the item is a complete sentence or not. 

 Except in procedure steps, avoid using vertical lists for only two items. 
 Use parallel structure for all items in a given list. 
 In list items, use all complete sentences or all sentence fragments; avoid 

mixing the two in a given list. 

Where to use lists 

 Do use lists in rules and guidelines topics for multiple items. 
 Do not use lists in rules and guidelines topics for a single item. 
 Do not begin the overview section of a topic with a vertical list. 
 Do not use lists for anything in the Heading 3 style. 
 Do use lists, where appropriate, for information below a Heading 3 style. 

 
Using Ordered and Unordered Lists Together 
Unordered list 
Ordered list 
Mixed unordered and ordered lists 
Exception 

 
 
 
 

Definition Lists 

Overview 
 
A definition list consists of a term and a definition or an explanation. 

Rules 

 if the term being defined is a field name, format the term in boldfaced font. 
 Format all other terms in normal font (not bold). 
 Separate the term from the definition with an em dash. Do not type spaces 

around the em dash. 
 Begin the definition or explanation with a lowercase letter (unless the word is 

a proper noun). 
 End the definition with a period only if the definition or explanation is a 

complete sentence. 

Correct 

Administrative assistants should familiarize themselves with 

 Associate Handbook—employment issues 
 Administrative Guide—general administrative tasks 
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There are two types of loan modifications: 
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 Advance and defer—a portion of the delinquency is advanced and 
deferred. 

 Step rate—when the debt-to-income ratio is more than 55%, the 
interest rate is lowered to bring the debt-to-income ratio down to the 
AMC Mortgage Services underwriting requirements. 

Incorrect 

The following are the current AMISC insurance vendors: 

 ACE INA: Disaster mortgage protection insurance plans. 
 American Home Shield (AHS): Home warranty insurance plans. 
 Monumental Life: Life and disability insurance plans. 

 

Multicolumn Lists 

Rules 

 Use a multicolumn list to group similar items; for example, a list of keywords. 
 Review these differences between multicolumn list and a table. 
 Use an unordered list for six or fewer items and a multicolumn list for seven 

or more. 
 Items in a multicolumn list need not be capitalized. 
 If the list is alphabetical, alphabetize down the columns, not across rows, if 

possible. 
 Because HTML does not support columns, multicolumn lists take the form of a 

table, with or without a heading row. 

Multicolumn List Example 

Common Measurements 
Distance 
Temperature 
Volume 
Size 
Weight 

Punctuation of List Introductions 

 After the infinitive phrase introducing procedure steps, use a colon. 

Correct [Infinitive phrase introducing procedure steps; Data Trace style requires a 
colon] 

To process a Western Union payment: 

1. Download the Quick Collect Client Web File each morning for the 
previous day. 

2. Reformat and save the file. 

 
Page 35 of 119 

3. . . .  



 If the words introducing a list include the phrases as follows, the following, 
and similar expressions, end the introduction with a colon. 

Correct [List introduction includes "the following"; use a colon.] 

The database includes the following: 

 Reports 
 Forms 
 Tables 
 Modules 

 If the words introducing a list constitute a complete sentence, end the 
introduction with a colon or a period. 

Correct 

Pick up the payoff request: 

 If it is an internal payoff request, retrieve the request from the 
designated payoff printer. 

 If it is faxed or a mailed request, retrieve from the bin. 

 If it is an internal payoff request, retrieve the request from the 
designated payoff printer. 

 If it is a faxed or mailed request, retrieve the request from the bin. 

 If the words introducing a list (other than an infinitive phrase) do not 
constitute a complete sentence, it is always correct to use no punctuation at 
all, but you may also use a colon. See the Important note below for an 
explanation of times when a colon should be avoided. 

Correct [List introductions are not complete sentences or infinitive phrases.] 

The closing agent 

 Facilitates the closing of a loan 
 Ensures the loan documents are properly prepared and signed 
 Ensures that the mortgage, deed of trust, or security deed and any 

riders are recorded and funds are properly disbursed 

The closing agent: 

 Facilitates the closing of a loan 
 Ensures the loan documents are properly prepared and signed 
 Ensures that the mortgage, deed of trust, or security deed and any 

riders are recorded and funds are properly disbursed 

The database includes    [Omitting a colon here is correct grammar.] 

 Reports 
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 Forms 



 Tables 
 Modules 

Incorrect 

The database includes: 

 Reports 
 Forms 
 Tables 
 Modules 

Note: The rules of grammar state that a colon should not be placed between a verb 
and its objects or a preposition and its objects. In the last example above, the colon 
is incorrect because it separates the verb "includes" from its objects. 

Punctuation of List Items 

 Always capitalize the first word of each list item whether the item is a 
complete sentence or not. 

 End list items with a period if they are complete sentences. 

Correct [List items are complete sentences; end each with a period.] 

1. Ask the Cashiering Department supervisor to unlock the Western 
Union printer cabinet. 

2. Tear off any checks that have been printed. 
3. Lock the Western Union printer cabinet. 
4. Detach the remittance section from the check. 

 End list items without any punctuation if they are fragments (not complete 
sentences). 

Correct [List items are fragments; do not use ending punctuation.] 

The following services are provided: 

 Explanations about preliminary title 
 Clarification on clearing open title exceptions 
 Information about state-specific requirements 
 Information about requirements for vesting changes 

Incorrect 

Complete a Collateral Memo (schedule of loans to be shipped) with the 
following: 

 Number of boxes, 
 Number of collateral packages, 
 "Attention to" information (from FedEx label), 
 Reference number (from the custodian log), and 
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 Transmittal number. 



 
 
Misused Words 
 

List of Misused and Easily Confused Words 

Overview 
 
This topic lists English words and phrases that are often misused or confused with 
other words or misspelled. Click a word or phrase for more information. 
 
    
affect, effect can, may, might impact onto, on to 
among, between cancel, cancelled, 

canceling, 
cancellation 

in, into preventative, 
prevent 

and/or comprise, compose in order to principal, principle 
appear, display data irregardless that, which 
appraise, apprise different its, it’s that, who 
as, because, since done, finished judgment their, them 
as, like entitled, titled matrix, matrices then 
assure, ensure, 
insure 

etc. more than, over utilize, utilizing 

auto-populate fewer, less, under off, off of via 
back up, backup grow on who, whom 
calendar if, whether once  
 

List of Words with Specific Style Guides 

Overview  
 
This topic lists specific words or phrases for which the Information Design 
Department has established a style preference for information designers to follow. 
Click a word or phrase for more information. 
 

  
access input 
approval levels Internet, intranet 
barcode off-site 
cc: offline 
email on-site 
enter, type online 
fax, facsimile screenshot 
file name Social Security number 
following Web, Webmaster, Web 

page, Web site 
inbox  
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Naming Conventions 
 

Boldfaced and Underlined Text 

 

Rules 

 Use boldfaced text for the following items: 
 Names of screens, windows, and panels 
 Names of Web sites and Web pages 
 Names of user interface elements (such as menus, commands, 

options, buttons, and check boxes) 

Exception: When field names appears in an Action/Explanation table, do 
not format the field name in bold. 

 User input (specific text that users type in fields) 
 Emphasis (but limit its use for this purpose) 

 In online documentation, use boldfaced text instead of italics for items that 
are normally italicized, such as book or manuscript titles. 

 If boldfaced text ends with a colon, make the colon boldfaced as well. 
 Do not use boldfaced text for field names used in tables. 
 In tables, apply the HeadingTable style to the header row. The HeadingTable 

style formats the text in boldfaced font. 
 Do not use boldfaced text for the following items (unless they are used in a 

heading or subheading): 
 Names of First American Title Corporation, affiliates, divisions, and 

departments 
 Job titles 
 File names 
 Names of documents, forms, reports, database queries, or database 

tables 
 Names of computer systems and software products 
 Names of online guides, such as the Associate Handbook 

 Do not use underlining in regular text; only hyperlinks should be underlined. 

Correct 

On the File menu, click Save. [names of interface elements] 
When prompted for the password, type newuser. [user input] 
After modifying the file, save it under a different file name. [emphasis] 
Refer to the Chicago Manual of Style. [name of book in online document] 

Field Action 
Warehouse Line Select a warehouse line. 
Confirmation Select Dry. 
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Document Conventions 

Data Trace has adopted a standard set of rules and guidelines designed to help 
information designers write online documentation that is consistent in style and 
usage. 

Rules 
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Item Convention Examples 
Accessory programs in 
Windows 

Title caps Notepad, Paint, WordPad 

Acronyms Usually uppercase asap!, AVM, bps, CFO, REO 
Book titles  Bold 

 Title caps 
 No italics 

The Chicago Manual of Style 

Commands on menus 
and buttons 

 

 Bold 
 Capitalization 

follows user 
interface 

 

Date and Time; Options; Tabs 
(Windows example) 

In TASKID, type FNTFOR, then 
press Enter. (mainframe system 
example) 

Dialog box (window) 
buttons 

 Bold 
 Capitalization 

follows interface 
 Use only the 

name of the 
button; do not 
write button 
after the name 

Click Close all programs and log 
on as a different user? 

Click OK. 

 

Dialog box (window) 
titles 

 Bold 
 Title caps 
 Refer to as 

window 

 

Protect Document window; 
Import/Export Setup window 

Error message names  Bold 
 Title caps 
 Refer to as error 

message 

 

General Protection Fault error 
message 

 

File Extensions All lowercase .chm; .doc; .mdb; .pdf 
Field names  Bold 

 Capitalization 
follows user 
interface 

 

In TASKID, type FNTFOR, then 
press Enter. (mainframe 
system example) 
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File names  Title caps 
(internal caps in 
short file names 
are acceptable 
for readability) 

 If a file name 
includes a 
variable, type 
angle brackets 
<> around the 
variable 
element, and 
format the angle 
brackets and the 
variable element 
in italic font 

 

Fee Matrix <MMDDYY>.xls 

Msacc20.ini 

SLA_InsuranceDept_<Year>.doc

 

Folders (Windows) and 
path names 

 Bold 
 Title caps 
 If a folder name 

includes a 
variable, type 
angle brackets 
<> around the 
variable 
element, and 
format the angle 
brackets and the 
variable element 
in italic font 

My Documents folder 

Form names  Title caps 
 Do not capitalize 

"report" or 
"request" unless 
it is part of the 
form name 

Collateral Package Audit 
Checklist/Stacking Order 

Icon names  Bold 
 Title caps 

 

Recycle Bin icon  
In Control Panel, click the Add 
New Hardware icon. 

Menu names  Bold 
 Title caps 

Insert menu 

New terms or emphasis 
(italics do not show up 
well online, so use bold 
for new or emphasis) 

 Bold 

 

Microsoft Exchange consists of 
both server and client 
components. 
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You must close the window 
before you exit. 

 
Online guide names  Initial caps 

 No bold 
DTS 2.0 User Manual 

Programs and 
applications, including 
utility and accessory 
programs 

 Usually title caps 
 No bold 
 Check Microsoft 

Trademark List 
for other styles 
of capitalization 

Microsoft Word 

Notepad 

Adobe Acrobat 

Report names  Title caps 
 Do not capitalize 

"report" unless it 
is part of the 
report name 

Check Request Total Report by 
Vendor 

Screen titles  Bold 
 Title caps 
 Refer to as 

screen 

the SER1 screen 

System and software 
product names 

 Usually title caps 
 No bold unless in 

a heading or 
subheading 

Microsoft Excel 

  

 
Toolbar button names  Bold 

 Usually title 
caps; follow the 
interface 

Format Painter 

Insert Microsoft Excel 
Worksheet 

URLs  All lowercase 
within 
parentheses 

 Include the 
protocol (such as 
https:// and 
ftp://) 

 Break long URLs 
before a forward 
slash, if 
necessary to 
break 
 

 

 Do not 

(http://www.google.com) 

(http://www.onelook.com) 

 



hyphenate 

 

 
User input  Bold 

 Usually 
lowercase, 
unless case-
sensitive or to 
match standard 
capitalization 
conventions 

 

In Password, type newuser. 

Web site and page 
names 

 

 Bold 
 Title caps 

 

IT Information Center 

eWorkforce 

Google 
Windows, named  Bold 

 Title caps 

 

Help window 

Windows, unnamed  All lowercase 
 No bold 

 

document window 

Wizards (in Windows)  Bold 
 Title case 
 Do not follow 

"Wizard" with 
the word 
"window" 

 

The New Project Wizard 
opens. 
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Numbers 
 

About Numbers 

Overview 
 
This topic describes basic guidelines for spelling out numbers or using numerals. The 
trend is toward using numerals whenever they can be justified, especially in technical 
and business writing. (In nontechnical or "humanistic" copy, the guidelines are 
different.) Other topics in this section describe how to use numbers in specific cases, 
such as dates, time, telephone numbers, addresses, and units of measure. 

Rules 

 Spell out zero to nine. 
 Use numerals for 10 and above. 
 Numbers that begin a sentence or list item are spelled out (see exception 

described in table below). 
 Ordinal numbers are treated the same as cardinal numbers. Spell out first 

through ninth. Use figures for 10th and above. 

The following table (drawn from The New York Public Library Writer's 
Guide to Style and Usage), explains basic rules for whether to spell out 
numbers or use numerals. It also lists examples and exceptions: 
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Number Style Quick-Reference Guide 
Spell out numbers zero to nine. 
If three payments are due for the loan, but only two payments are received, 
process the payments. 

Snow White had seven dwarfs. 
Ordinal numbers for first to ninth. 
The Riverside branch placed first in the Quality Circle rankings. 

Process the report on the third of the month. 
Exceptions 
With numbers nine and below grouped for comparison in the same sentence 
or paragraph with numbers 10 and above: 

3 of 21 students 
9th and 12th grades 
With numbers preceding units of measure, symbols, and abbreviations: 

6.25% 
5-inch border 
8°C 
4 MB RAM 
5-mg dose 
5 basis points (bps) 
level 3 approval or above 



With names of parts of books, series, tables, and similar items: 

chapter 2 
volume 7 
row 9 
grade 3 
figure 6 
With percentages, mixed fractions, decimals, ratios, and table coordinates: 

1% 
2½ years 
1.3 times 
2 to 1 (ratio) 
row 3, column 4 
With ages: 

7-year-old house 
3-year-old child 
9 years old 
With sums of money: 

$5 
$5.25 
$7 million 
With dates and times: 

6 hours 
2 days 
3 weeks 
appraisals more than 6 months old 
January 25, 1944 
30-year-fixed mortgage 
21st century 
But two centuries, five decades 
 

 Do not add ly, as in firstly, secondly. 
 Represent numbers taken from examples or system interfaces exactly as they appear 

in the example or interface. 

Dates 

 

Rules 

 Within text do not spell out the numbers in dates; write them as figures. See 
the Comma topic for information about punctuating dates in text. 
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Correct 

The next training session begins June 4. 
The proposal is due August 9, 2007, and the bidders' conference will be held 
the following week. 

Incorrect 

The next training session begins 06/04/2007. 
The proposal is due on August ninth, 2005, and the bidder's conference will be 
held the following week. 

 Use cardinal numbers for dates. Use ordinal numbers only when the specific 
month is not named, as in the second and third correct examples. 

Correct 

The meeting is scheduled for April 1. 
The supervisor generates the Past Sales report on the fifth day of each month. 
(Since this date is a number under 10, spell out the ordinal number.) 
The supervisor generates the Future Sales report on the 15th day of each 
month. (Since this date is a number over 10, do not spell out the ordinal 
number.) 

Incorrect 

The meeting is scheduled for April 1st. 

 When a date consists of the month and year only, no comma is needed. 

Correct 

The guidelines were established in the March 2005 bulletin. 

 Use a slash (/), rather than hyphens, in date formats such as MM/DD, MM/YY, 
MM/DD/YY, and MM/DD/YYYY. 

Correct 

03/04/05 

Incorrect 

03-04-05 

 In the MM/DD/YY, MM/DD/YYYY, and similar date formats, always use two 
digits for the month and day, even if they are less than 10. 

Correct 
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03/04/05 



03/04/2005 

Incorrect 

3/4/05 

Percentages and Fractions 
 

Rules 

 For percentages, use figures and the percent sign. 

Correct 

6.25% APR 
10% 

 Use figures to express ratios, proportions, and odds. 

Correct 

The base loan-to-value (LTV) ratio is 90%. 
The horse was favored by odds of 9 to 1. 

 Common fractions used alone, without a whole number preceding, are usually 
spelled out. Such common fractions include 

Correct 

one-half 
three-quarters 
one-eighth 
two-thirds 

 The suffixes -nds and -ths are unnecessary. 

Correct 

3/8 inch 
9/32 inch 
7/16 inch 

Incorrect 

3/8ths of an inch 
9/32nds inch 
7/16ths inch 
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 Use figures with decimal fractions. 



Correct 

The typical American household has 1.9 persons. 

 Use the singular when fractions and decimals of one or less are used as 
adjectives. 

At first glance, saying .8 tons may seem correct. But .8 ton is a decimal 
representation for eight-tenths, or four-fifths. Four-fifths is less than one, and 
when there’s one or less of anything, it’s singular, not plural. One would not 
say half a tons. 

Correct 

0.9 pound 
0.3 centimeter 
0.44 cubic foot 
¼ mile 

Punctuation with Numbers 

Rules 

 In general, use commas in numbers that have four or more digits. 

Correct 

1,024 bytes 
1,273 units 

 When designating years and baud rates, however, use commas only when the 
number has five or more digits. 

Correct 

10,000 B.C. 
9600 baud 
14,400 baud 

 Do not use commas in page numbers, addresses, or decimals. 

Correct 

page 1091 
1100 Town & Country Road 
1.06377 units 

 Hyphenate compound numbers when they are spelled out. 
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Correct 

Twenty-five fonts are included. 
The forty-first user encountered problems. 

 For negative numbers, use an en dash, rather than a hyphen: –79 
 When two numbers in different clauses are separated only by a comma, write 

one as numerals and the other as words. 

Correct 

When the count reaches 6,420, four hundred and twenty units will be recalled. 

 

Incorrect 

When the count reaches 6,420, 420 units will be recalled. 

Ranges of Numbers 

 
Rules 

 Although it is always preferable to use the words "through" or "to" with dates, 
times, and dates of the week in text, en dashes are sometimes used, 
especially in lists, tables, or other kinds of displayed information: 

Preferred 

$5 to $20 
from pages 38 through 45 
9:00 a.m. to 3:00 p.m. 

Acceptable where space is tight 

$5–$20 
pages 38–45 
9:00 a.m.–3:00 p.m. 

 Do not use from before a range indicated by an en dash. 

Correct 

1985–1990 

Incorrect 
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from 1985–1990 
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 Avoid using between or and to describe an inclusive range of numbers 
because it can be ambiguous. 

Correct 

from 9 through 7 

Incorrect 

between 9 and 17 

Telephone Numbers 

 
Rules 

 Use parentheses, not a hyphen, to separate the area code from the seven-
digit phone number. 

 Use a hyphen to separate the final seven digits into groups of three and four. 
 For telephone extensions, separate the telephone number from the extension 

with a comma and a space. Type the abbreviation x, rather than Ext. or 
Extn. 

 Do not precede the area code with a 1. 

Correct 

(714) 541-9999, x15712 
(800) 430-5262 

Incorrect 

303-823-8500 
303.823.8500 
(714) 541-9999 Ext. 15712 
1-(800)-555-0123 
1-800-555-0123 

 
Time 

 
 
Rules 

 Use numerals to indicate the time of day. In most cases, express time using a 
12-hour clock (rather than a 24-hour clock). Include minutes when showing 
times followed by a.m. or p.m. 

Correct 
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8:15 a.m. 



4:30 p.m. 

 When referring to 12 a.m. or 12 p.m., eliminate confusion by specifying 
12:00 noon or 12:00 midnight. 

 The names of time zones should be treated as proper nouns. A time zone is a 
geographical area. 

Correct 

Eastern Time 
Pacific Time 

Incorrect 

eastern time 
Pacific time 

 Avoid specifying standard time and daylight time, which refer to clock settings 
within a time zone at specific times of the year, unless you are referring to an 
event, such as a Webcast, for which this information is important. 

Incorrect 

Central Daylight Time 
eastern standard time 

 Do not abbreviate the names of time zones, such as PT and ET, unless space 
is severely limited. 

Units of Measure 
 
 

Rules 

 Use numerals for all measurements, even if the number is under 10, whether 
the measurement is spelled out, abbreviated, or replaced by a symbol. 

 Units of measure include units of distance, temperature, volume, size, 
weight, points, picas, and time (such as hours, days, weeks, and years). 

 Percentages and basis points are considered units of measure as are bits and 
bytes. 

Common Measurements
Basis points 
Bits and bytes 
Distance 
Percentages 
Points and picas 
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Correct 

25 basis points (bps) 
6% 
0 inches 
3 feet, 5 inches 
3.5-inch disk 
5 weeks 
6 months 
0.75 gram 
35mm camera 
8 bits 
1-byte error value 

 Ages of people and things are usually expressed in figures. 

Correct 

3 months old 
7-year-old home 

 Place a hyphen between a number and unit of measure when they modify a 
noun. The hyphens make it clear that the numbers modify the units of 
measure, not the nouns. 

Correct 

2-week-old culture 
15,000-volt charge 
12-inch-long ruler 

Incorrect 

12 inch long ruler 
12-inch long ruler 

 Use numerals in dimensions. 

 In most text, spell out by, except for screen resolutions; for those, use the 
multiplication sign (×). 

Correct 

8.5-by-11-inch paper 
600 × 800 screen resolution 
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Procedure Writing 
 

Commands 

 
 
Rules 
 

Use the following syntax for Windows commands. 
 
When you want the user to  Use this syntax 
Carry out a command from a program 
menu 

On the Tools menu, click Address Book. 

 
Carry out a command from a program 
menu 

On the Tools menu, click Address Book. 

 
Carry out an action from a window 
reached from a menu command 

On the Tools menu, click Language > 
Hyphenation. The Hyphenation window 
opens. 

Select the Automatically hyphenate 
document check box. 

Carry out a command from a window Click Apply. 
Carry out a command from a submenu Click the Start button, point to 

Documents, and then click the desired 
document. 

Click Start > Programs > Windows 
Explorer. 

 

File Names and Folders 

Overview 
 
Many topics refer to files saved in network folders. File names and folder names may 
include variables, such as months or years. 

 
Rules 

 To enhance readability, display folder names and file names on separate lines. 
 Type two manual line breaks (Shift+Enter) to insert vertical space between 

the procedure step and the folder name. 
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Note: Manual line breaks maintain the numbering on subsequent steps. 
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 Type the word Folder: in boldfaced font. If required by your clients (Loan 
Servicing and Special Servicing clients expect it), type the drive letter 
followed by a colon and the word drive. 

 Type a backslash character \ between each folder. 
 At the end of the folder path, type a backslash character \. 

 
Example: 
(S: drive): \\corpdata10\retail\ORGDEV\IDD\Templates\ 

 If appropriate, create a hyperlink to the folder. 
 Type a manual line break (Shift+Enter) at the end of the folder name to 

create a new line. 
 Type the words File name: in boldfaced font, followed by a colon. 
 Type the file name and the file extension. 
 If any part of a folder or file name includes a variable, type angle brackets <> 

around the variable name. Format the angle brackets and the variable name 
in italic font. 

 When a folder or file name includes a variable, provide an example. Type two 
manual line breaks, and then type the word Example: in boldfaced font. Type 
the full folder path and file name, including file extension. In the example, 
replace each variable with a reasonable value. 

Correct 

1. Open the State Procedure Matrix Excel file. 
Folder (N: drive): \\corpdata06\lsshare\Shared Apps\Finance-
SharedServices\AllSSMatrix\ 
File name: State Procedure Matrix.xls 

2. Save the results. 
Folder (S: drive): \\corpdata10\lserv\CSSupport\Daily 
Balancing\<Year>\<Month>\ 
File name: Daily Bal <MM-YY>.xls 
 
Example: \\corpdata10\lserv\CSSupport\Daily 
Balancing\2006\10\Daily Bal 10-06.xls 

Guideline 
 
Use your best judgment when defining variable names. For example, <Year> is 
reasonable to identify a year; <XXXX> is not. 
 

Multiple-action Procedure Steps 

Overview 
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A multiple-action procedure step is one that requires users to complete two or more 
short actions. 



 
Rules 

 As a general rule, set individual steps as separate, numbered entries; 
however, short steps can be combined if they occur in the same place (within 
one screen or window, for example). 

 Use the greater than sign > for long navigation sequences through cascading 
menus. Use this technique only if the navigation is obvious to any new user of 
the application. 

 Long navigation sequences are two or more clicks within a single 
application. 

 Place a space on either side of the > to facilitate line breaks. 
 Use boldfaced text for the entire sequence. 
 Optionally, include a screenshot (using the ImageLink style) of the 

menu to clarify the navigation steps. 

Correct 

On the PeopleSoft Menu, click General Ledger > Journals > Journal Entry > 
Create Journal Entries. 

On the Tools menu, click Language > Hyphenation. The Hyphenation 
window opens. 

 Do not combine menu and tab options in long navigation sequences. 

Correct 

1. On the Tools menu, click Options. 

2. On the Options window, click the Edit tab. 

Also Correct 

On the Tools menu, click Options, and then click the Edit tab. 

Incorrect 

On the Tools menu, click Options > Edit. 

 When describing several short steps in one sentence, do not use a semicolon 

Correct 

On the File menu, click Generate, and then click WebHelp. 

Incorrect 
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On the File menu, click Generate; then click WebHelp. 



 When writing complex steps that need more explanation, create a drop-down 
hotspot in the ViewHideDetails style. 

Example of a DHTML drop-down hotspot, with expanded steps visible 

1. In Empower, open the Loan Summary window. view/hide details  
a. With the loan open, click Underwriting from the workflow, and 

then click Loan Summary. 
b. Double-click Loan Summary from the right pane. The Loan 

Summary window opens. 

  

Procedure Style 

 
 
Rules 

 Avoid references to the names of specific individuals and their telephone 
numbers and extensions in procedures; instead, refer to the department 
name. 

 Follow interface capitalization. Usually, menu and command names use title 
caps. Capitalization of window options varies. If in doubt, or if necessary for 
consistency, use sentence-style capitalization. 

Correct Windows example 

1. Click Date and Time. 
2. Select the Provide feedback with sound check box. 

Correct mainframe example 

1. Go to the MSP TSK1 screen. 
2. In TASKID, type FNTFOR, and then press Enter. The TSK1 screen 

opens. 
3. In ACT, type A, and then press Enter to order tax information. 

 If a command name of a dialog box option ends with a colon or ellipsis, do 
not include this punctuation. 

Correct 

Click Save As. 

Incorrect 

Click Save As… 
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 Limit the use of the descriptors button and option button, except where the 
descriptor helps to avoid confusing or awkward phrasing or is necessary to 
avoid confusion with another element. 
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 Use bold for user input and regular type for descriptors. User input can be on 
the same line as the procedural step, or it can be displayed on a new line. If 
the input is on the same line, what the user types should be the last word or 
words of the step and should not be followed by end punctuation unless 
the user needs to type the end punctuation. 

Correct 

Type the user password. 

In the Date box, type April 1. 

In the Date box, type the following: 

April 1 

 

Procedure Syntax 

 
 
Rules 

 As a general rule, tell users where the action should take place before 
describing the action to take. This practice prevents users from doing the 
right thing in the wrong place; however, avoid overloading procedures with 
"locators." 

 Assume that the user is looking at the screen and is starting from the position 
where the procedure begins. For example, the following phrasing is typical: 
On the View menu, click Zoom. 
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 Use the greater than sign > for long navigation sequences through cascading 
menus. Use this technique only if the navigation is obvious to any new user of 
the application. 



Folders and icons 

 Users click or double-click a folder or an icon to initiate an action; for 
example, starting a program or viewing a list of subfolders. 

 
When you want the user to  Use this syntax 
Activate a program icon that is already 
running on the desktop 

Click the Microsoft Excel button on the 
taskbar. 

Switch to Microsoft Excel. 
Select an icon before changing its 
properties, moving it and so on 

Right-click the PowerPoint icon, and then 
click Properties. 

Choose a Control Panel icon In Control Panel, double-click the 
Printers icon. 

Choose any other icon, such as a folder 
icon, drive icon and so on 

Double-click the Recycle Bin icon. 

 
 

Tables in Procedures 

Use tables in procedures to organize field information and to make the procedures 
user-friendly. 

 
Rules 

 Use a table in procedure steps to describe screens with two or more fields. 

Correct 

Use the following table to type the relevant information in each field. 

Field  Action information 
STAT Type A, indicating that the status is active. 
TEMPLATE Type LMOFF. 
PROC Type the processor's code that identifies 

the Home Retention specialist. 
STAGE Type the appropriate pending code. 

Note: The Home Retention specialist 
changes the STAGE code only when the 
file is approved. If the file is declined, or 
upon completion or cancellation, the Home 
Retention specialist closes the file in the 
workstation with the applicable removal 
code. 
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 To avoid long tables, chunk the data. Many screens and windows display 
fields in group boxes; these group boxes provide logical break points. When a 
screen has three or more group boxes, describe each section in a separate 
table. 

Correct 

1. Update the Update My Current Tasks page of Project Manager. 
a. Complete the fields in the Task section. 

Field  Action information 
Deadline Click the appropriate date on the calendar, 

and then double-click the Done field to 
copy the selected date into the field. 

Est Hrs Type the estimated number of hours in the 
Est Hrs field. 

Late Reason Type a description if the task is late in the 
Late Reason field. 

Description Type a description of the task in the 
Description field. 

 
      b. Complete the fields in the Goals section. 

 
Field  Action information 
Week Select the date from the Week drop-down 

list. 
Done Click the appropriate date on the calendar, 

and then double-click the Done field to 
copy the selected date into the field. 

Completed Stage Select the stage from the Completed 
Stage drop-down list. 

Goal Click the appropriate date on the calendar, 
and then double-click the Goal field to 
copy the selected date into the field. 

Goal Stage Select the stage from the Goal Stage 
drop-down list. 

 
c. Complete the fields in the Reviews section. 

 
Field  Action information 
Reviewer Type the reviewer's name in the Reviewer 

field. 
Due Click the appropriate date on the calendar, 

then double-click the Due field to copy the 
selected date into the field. 

Approved Click the appropriate date on the calendar, 
then double-click the Approved field to 
copy the selected date into the field. 

Notes Type notes related to the review in the 
Notes field. 
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Punctuation 

Apostrophe 

 
 
Rules 

 use apostrophes to form the possessive case of nouns and to indicate a 
missing letter in a contraction. 

 Form the possessive case of a singular noun by adding an apostrophe and an 
s, even if the singular noun ends in s, x, or z. 

 Form the possessive of a plural noun by adding an apostrophe after the final 
letter. 

 Do not use possessives for product or feature names. 

Correct 

the index’s structure 

Data Trace’s property 

an OEM’s product 

all of the software modules' features. 

the features in Word 

Incorrect 

Word's features 

all of the software modules's features. 

Brackets 

 
 
Rules 

 Use brackets for parentheses within parentheses. 

Correct 

This format has been superseded by another (see ABC Manual of Style 
[Revised Edition], pp. 46–72). 
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Incorrect 

This format has been superseded by another (see ABC Manual of Style 
(Revised Edition), pp. 46–72). 

 Use brackets to enclose editorial interpolations, corrections, explanations or 
comments in quoted material. 

Correct 

Despite evidence brought to light [by the recent study], they continued on 
course. 

They were certain that everyone [who was interested] would attend. 

Incorrect 

They were certain that everyone (who was interested) would attend. 

Colon 

Overview 
 
A colon is a mark of introduction. It can precede a quotation, a list, an explanation, 
or a main clause. 

 
Rules 

 Use a colon after an infinitive phrase introducing procedure steps. (This use of 
the colon after a phrase, rather than a complete sentence, is a Data Trace 
style decision.) 

 Use a colon after a complete sentence that introduces a list. 
 A colon is normally used after as follows, the following, and similar 

expressions. 
 If the introduction to a list is not a complete sentence or an infinitive phrase 

introducing procedure steps, do not use a colon. 
 A colon is incorrect before a series introduced by a verb or a preposition. (A 

colon should never come between a verb and the rest of the sentence, and 
between a preposition and its object.) 

 A colon is incorrect after words like including, namely, for example, and 
such as. 

Correct [colon follows a complete sentence] 

Audit the checks against the Interest Adjustment Checks Issued Log: 

 Verify check amounts. 
 Verify the number of checks. 
 Highlight any day differences greater than 15 days. 
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Incorrect [colon appears between the verb will and the rest of the sentence] 



To issue interest adjustment checks, the Shipping Department 
associate will: 

1. On the Shipping tab of the Empower toolbar, click the Interest 
Adjustment icon. 

2. In Branch Manager Signoff Date, type the appropriate date. 

Incorrect [colon should not appear between the preposition for and its objects] 

The Postfunding Group is responsible for: 

 Using the Funded Loans with Outstanding Stip 99999 Report to monitor 
stipulations 

 Clearing exceptions  
 Researching stipulations 
 Obtaining additional information from the originating branch  
 Working with the funding supervisor on any questionable stipulations 

 Do not use a colon to introduce graphics, tables, or sections. 
 Use colons sparingly; do not overuse them. 
 Use only one space after a colon. 
 When boldfaced text appears before a colon, use bold for the colon as well. 

Capitalizing after a Colon 

 After a colon, capitalize the first word if the clause is a complete sentence, 
and lowercase the first word if the clause is a fragment. 

Correct 

Be sure the loan package is complete: A complete loan package includes a 
Loan Application form, a financial statement, and proof of income. 

Colons with Quotation Marks 

 When using a colon with quotation marks, place the colon outside the last 
quotation mark. 

Correct 

The style to use for the following document types is "technical writing": user 
manuals, system documentation and procedure guides. 

Incorrect 

The style to use for the following document types is "technical writing:" user 
manuals, system documentation and procedure guides. 
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Comma 

 
 
Rules 

 Items in a series are normally separated by commas. When a conjunction 
joins the last two elements in a series, a comma—known as the serial 
comma, series comma, Oxford comma, or Harvard comma—should appear 
before the conjunction. 

 Use commas to separate parts of a sentence and to clarify thoughts within a 
sentence. 

 When the clauses of a compound sentence are joined by a conjunction, a 
comma should be placed before the conjunction unless the clauses are short 
and closely related. 

 In a compound sentence composed of a series of short independent clauses 
the last two of which are joined by a conjunction, the comma should be 
placed between the clauses and before the conjunction. 

 Do not join independent clauses with a comma; use a semicolon or two 
shorter sentences. 

Correct 

Harris presented the proposal to the manager, the manager discussed it with 
the supervisor, then the supervisor made an appointment with the president. 

Reports, proposals, and manuals are the responsibility of the Technical Writing 
Department; the Advertising Department handles brochures, catalogs, and 
press kits. 

Reports, proposals, and manuals are the responsibility of the Technical Writing 
Department. The Advertising Department handles brochures, catalogs, and 
press kits. 

Incorrect 

Reports, proposals, and manuals are the responsibility of the Technical Writing 
Department, the Advertising Department handles brochures, catalogs, and 
press kits. (no semicolon) 

 A comma should be placed before and after the year in a three-part date. 

Correct 

The Declaration of Independence was signed on July 4, 1776, but the U.S. 
Constitution was not adopted until September 17, 1787, more than 11 years 
later. 
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 Commas are usually used to set off the abbreviation Inc. unless the 
company's preference is to drop the comma. When commas are used, they 
are placed before and after the abbreviation when it appears in a phrase or 
sentence. 



Correct 

ABC Company, Inc., may postpone a foreclosure sale. [The company name 
includes a comma before Inc.] 

Citigroup Global Markets Inc. is an approved vendor. [The company name does 
not include a comma before Inc.] 

Dash 

Overview 

Four types of dashes exist, although only the first two are likely to be used in Data 
Trace documentation. The dashes are as follows: 

 Em dash 
 En dash 
 2-em dash 
 3-em dash 

This topic describes rules for using the em dash and en dash. 

According to The Elements of Style, an em dash is "a mark of separation stronger 
than a comma, less formal than a colon, and more relaxed than parentheses. Use a 
dash only when a more common mark of punctuation seems inadequate." 
 

Rules 

 Use em dashes to set off defining or enumerating complementary elements 
that are added to or inserted into a sentence. 

 When using an em dash within a sentence, do not put spaces between the 
em dash and the text—keep the text next to the dash. 

Correct 

The information—text, numbers, and formulas—is stored in cells. 

Incorrect 

The information — text, numbers, and formulas — is stored in cells. 

 Do not use em dashes in place of bullets or other typographic symbols to set 
off items in a list. 

Incorrect 

The report contains the following information: (use bullets instead) 
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—New housing starts 
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—Unemployment claims 

—Area demographics 

 When a sentence follows an em dash, do not capitalize the first word unless it 
is a proper noun. 

Correct 

Layoffs, foreclosures, and high interest rates—these all contributed to a weak 
housing market. 

Layoffs, foreclosures, and high interest rates—Smith stated that these all 
contributed to a weak housing market. 

 Use en dashes to indicate continuing, or inclusive, numbers, such as dates, 
times, or reference numbers. 

Correct 

2002–2003 

May–June 2003 

10:00 a.m.–2:00 p.m. 

10:30 a.m.–2:30 p.m. 

pp. 55–60 

Incorrect (use an en dash instead) 

Fiscal years 2003—2004 

 Use en dashes to indicate negative numbers or minus signs. 

Correct 

–24 (minus or negative 24) 

 Use en dashes in place of hyphens in compound adjectives, one element of 
which consists of two words (such as Windows 2000) or a hyphenated word 
(such as MS-DOS). 

Correct 

Windows 2000–based programs 

MS-DOS–compatible products 
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Incorrect 



Windows 2000-based programs 

MS-DOS-compatible products 

Ellipses Point 

Overview 
 

Rules 
 

Ellipsis points (or marks) are a series of three dots that indicate the omission of 
quoted words. Other uses of ellipses are to show a trailing off of thought at the end 
of a sentence or to show a pause, as is done with a comma or a dash. 

 If ellipsis points replace the end of a sentence, follow them with a closing 
period, with no intervening space. 

Correct 

The quick brown fox …. 

 If a table is used to display if/then information, use ellipses in column 
headings. 

Correct 

If the check… Then… 
Contains a return address Return the check to the sender. 

 
Does not contain an address Shred the check. 

 
 
Note: In RoboHelp, insert ellipses by clicking the Insert menu, then clicking 
Symbol. 
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Exclamation Point 

Overview 
 
An exclamation point (!) is a mark of punctuation used at the end of a sentence to 
show urgency, surprise, enthusiasm, disbelief, or strong emotion. 

 
Rules 

 Use exclamation points only after true exclamations or commands. 

Correct 

Attention! 

Incorrect 

It was a wonderful show! 

 Never use more than one exclamation point after a command or exclamation. 

Incorrect 

Attention!!! 

Parentheses 

 
 
Rules 

 Do not use "parenthetical plurals." They are hard to read and, in many cases, 
present subject-and-verb agreement problems. 

Correct 

Return the forms and invoices to Accounts Payable using interoffice mail. 

Provide full addresses and telephone numbers for all applicants. 

Incorrect 

Return the form(s) and invoice(s) to Accounts Payable using interoffice mail. 

Provide full address(es) and telephone number(s) for all applicants. 
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 When an expression within a sentence is put into parentheses, it is 
punctuated as if it stood by itself; no punctuation comes at the end of the 
expression (as shown here) unless it is a question mark or explanation point 
(as shown here!). 
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 (When an entire sentence is parenthesized, as shown here, the period falls 
inside the final parenthesis mark.) 

 Numerals or letters enumerating items in a list within a paragraph should be 
enclosed in parentheses and should not be followed by a period. 

Correct 

He went to the manager's office (his third attempt to see her), but she was 
gone. 

He stated (and why should we doubt him?) that the calculations were accurate. 

The two folders are (1) Goals and (2) Accomplishments. 

Incorrect 

He went to the manager's office (his third attempt to see her,) but she was 
gone. 

The two folders are 1) Goals and 2) Accomplishments. 

 Use brackets for parentheses within parentheses (see Brackets). 
 

Period 

 
Rules 
 

Terminal Punctuation 

 Use a period to indicate the end of a declarative or imperative sentence. 
 Omit the period at the end of a sentence that is included within another 

sentence. 

Correct 

The file (it is located on the network server) contains the necessary 
information. 

 Use a period after numerals or letters used to enumerate items in a vertical 
list. 

Correct 

1. Log on to Vision. 
2. On the Loan menu, click Search by Account Number. 
3. In Enter Account Number, type the loan number, and then click OK. 
4. In Note, type any information about the status and steps completed 

for the deed-in-lieu. 
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5. Copy the information in Note, and paste it into Special. 



Periods with Quotation Marks, Parentheses, and Brackets 

 Place periods within quotation marks. 

Correct 

In the text, look for the following quote: "This is a test." 

He was unfamiliar with the term "categorical imperative." 

 When parentheses or brackets are used to enclose an independent sentence, 
the period belongs inside. 

Correct 

He insisted on rewriting the first paragraph. (He made no other changes.) 

 If the enclosed matter is part of an including sentence, the periods should be 
placed outside the parentheses or brackets. 

Correct 

He insisted on rewriting the first paragraph (but he made no other changes). 

Display Lines, Headings, and Legends 

 Omit the period after display lines, running heads, centered headlines, column 
heads in tables, one-line superscriptions, legends, and date lines that head 
communications. 

Correct 

Sale Prices Good for This Month Only (headline) 

New version, dated 04/10/03 

Incorrect 

Sale Prices Good for This Month Only. 

IDD Standards and Style Guide, version 1.0. 

New version, dated 04/10/03. 
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Question Marks 

Overview 
 
The question mark is used to mark a query or to express an editorial doubt. 

Rules 

 Use a question mark at the end of an interrogative element that is part of a 
sentence. 

Correct 

How can the figures be reconciled? was the question on everyone’s mind. 

Incorrect 

How can the figures be reconciled was the question on everyone’s mind? 

 When the question consists of a single word (such as who, when, how, or 
why) within a sentence, neither question mark nor capital letter need be 
used. 

Correct 

The question was no longer how, but when. 

He wondered why. 

 A request courteously disguised as a question should not be terminated by a 
question mark. 

Correct 

Will you please rush the manuscript to the publisher. 

Will the audience please rise. 

Incorrect 

Will you please rush the manuscript to the publisher? 

 Indirect questions should not be followed by a question mark. 

Correct 

He was thorough enough to ask whether they had seen the report. 

He was thorough enough to ask, "Have they seen the report?" 
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Incorrect 



He was thorough enough to ask whether they had seen the report? 

He was thorough enough to ask, "Have they seen the report"? 

 

Quotation Marks 

 
 
Rules 

 Formal quotations cited as documentary evidence should be introduced by a 
colon and enclosed in quotation marks. 

 A quotation grammatically in apposition or the direct object of a verb should 
be preceded by a comma and enclosed in quotation marks. 

 If a period or comma comes at the end of a quotation, place the period or 
comma inside the last quotation mark. This rule always applies, regardless of 
the reason for the quotation. 

 Place colons and semicolons outside quotation marks. 

Correct 

The manual states: "Avoid quotes unless absolutely necessary," so avoid them 
whenever possible. 

The reviewer says, "Keep it short and simple." 

The following message appears: "Updating file to reflect changes." 

The style to use is "technical writing"; it differs from expository writing.  

Incorrect 

The reviewer says, "Keep it short and simple". 

The style to use is known as "technical writing;" it differs from expository 
writing styles.  

System Input 

 When instructing a user to type text, omit the quotation marks. Otherwise, 
users may become confused and believe that they should also type the 
quotation marks. 

Correct 

Type This is a test. 

Incorrect 
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Type "This is a test." 



 Place a dash, question mark or exclamation point inside the quotation marks 
when it applies only to the quotation; place it outside the quotation marks 
when it applies to the whole statement. 

  

Correct 

She said, "Will you be at work tomorrow?" 

Didn't she say, "Will you be at work tomorrow"? 

Incorrect 

She said, "Will you be at work tomorrow"? 

 When a mark applies to both quotation and sentence, use it only once. 

Correct 

Have you ever asked, "May I come in"? 

Incorrect 

Have you ever asked, "May I come in?"? 

 

Semicolon 

Overview 
 
A semicolon is used to mark a more important break in sentence flow than that 
marked by a comma. 
 

Rules 

 Use a semicolon between the two parts of a compound sentence 
(independent, or coordinate, clauses) when they are not connected by a 
conjunction. 

 Use semicolons sparingly; in user manuals, independent clauses should 
generally be written as two short sentences rather than one long sentence 
with a semicolon. 

 The following words are considered adverbs rather than conjunctions and 
should therefore be preceded by a semicolon when used transitionally 
between clauses of a compound sentence: then, however, thus, hence, 
indeed, accordingly, besides and therefore. 

Correct 
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The proposal was modified as requested; it now includes an escalator clause. 



The proposal was submitted late; hence, there was a delay in granting funds. 

The proposal was submitted late; however, the funds were granted on time. 

Incorrect 

The proposal was modified as requested; and it now includes an escalator 
clause. 

The proposal was modified as requested, it now includes an escalator clause. 

 If several semicolons are called for, it may be less convoluted and clearer to 
the reader if the sentence is broken out into an unordered (bullet) list. 

 Remember to capitalize the first word after each bullet. 

Correct 

In this tutorial, readers will learn to 

 Quickly construct a user interface 
 Easily implement both single-document interface and multiple-

document interface applications 
 Implement features that until now were considered difficult, such as 

printing, toolbars, scrolling, and context-sensitive help 
 Take advantage of many built-in components of the class library 

Incorrect (Convoluted) 

In this tutorial, readers will learn to quickly construct a user interface; easily 
implement both single-document interface and multiple-document interface 
applications; implement features that until now were considered difficult, such 
as printing, toolbars, scrolling, and context-sensitive help; and take advantage 
of many built-in components of the class library. 

 When using a semicolon with quotes, place the semicolon outside the 
quotation marks. 

Correct 

The style we use is "technical writing"; it differs from expository writing. 

Incorrect 

The style we use is "technical writing;" it differs from expository writing.  
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Slash 

 
 
Rules 

 Do not use "slashed constructions"; they damage writing clarity and 
readability. (Exceptions: read/write, input/output, and and/or) 

Correct 

plat map or location map 

Shipping Department associates or credit analysts 

Incorrect 

Deed/Mortgage/Instrument 

plat map/location map 

Shipping Department associates/credit analysts 

 Use a slash (/), rather than hyphens, in the MM/YY, MM/DD/YY, MM/DD/YYYY, 
and similar date formats. 

Correct 

04/01/07 

05/02/2007 

Incorrect 

04-01-07 

05-02-2007 

 Use a slash to indicate periods or seasons extending over parts of two 
successive calendar years. 

Correct 

fiscal year 2006/07 
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Review and Approval Process 
 

Peer Reviews and Edits 

 
 
Rule 
 

Although peer reviews are not specifically included in the Review Process Table (see 
Review and Approval Process), information designers are encouraged to seek the 
advice and review of other writers when drafting material, especially if the subject 
matter is long and complex. Peer reviews and edits can also help technical writers 
strengthen their writing and editing skills. 
 
 
 
 
RoboHelp Project Styles 
 

Adding Words to the RoboHelp Dictionary 

 
RoboHelp and other software products often use inadequate dictionaries. These 
dictionaries do not recognize many proper names and incorrectly "flag" many words 
as misspellings (with red wavy underlining) when they are spelled correctly. To 
eliminate such incorrect flags, add words to the RoboHelp dictionary by following this 
procedure. 
 
Procedure 
 
To add a word to the RoboHelp dictionary: 

1. Select the word you want to add. 
2. Right-click, and then point to Spelling. 
3. Click Add To Dictionary. 
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Note: Words can also be added to the RoboHelp dictionary during the spell-check 
process. 



Creating Glossary Terms 

 
This topic describes how to create a glossary term topic, how to create the link 
between topic text and the term, and how to apply the "Glossary text" style to the 
link text. 
 
 
Procedure 
 
To create a glossary term topic: 

1. In the RoboHelp project, click the Create a New Topic icon. 
2. In the New Topic window, in Topic Title, type the name of the term you 

intend to define. 
3. In File Name, type the file name, including the information type of GL_. 
4. In Template, click GlossaryTerm. 
5. Click OK. A new topic opens; the name of the term appears in the GlossTerm 

heading style. 

To create a hyperlink between topic text and a glossary term topic: 

1. Highlight the word or phrase that you want to serve as the link to the 
glossary term. 

2. Click the Insert Hyperlink icon. 
3. Under Hyperlink Options, click Display in auto-sizing popup. 
4. In Select destination (file or URL), locate the glossary term topic to which 

you want to link. 
5. Click OK. 
6. While the link text is still highlighted, in the RoboHelp Style box, click 

Glossary text. 
7. Test the link to ensure that the glossary term appears in an auto-sizing 

window. (Click the View Selected Item icon (eyeglasses), and then click the 
green link text.). 

 

Creating See Also Buttons 

 
Procedure 

To create a See Also button: 
 

1. Open the topic in which you want to add a See Also button. 
2. On the Insert menu, click See Also. The See Also Wizard opens. 
3. Complete the See Also Wizard—Link Options window. 
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4. Complete the See Also Wizard—See Also Keywords Selection window. 
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5. Complete the See Also Wizard—Display Options window. 

 
 

6. Complete the See Also Wizard—Font Options window. 

 

 
 

7. Copy and paste the See Also button into each topic that should receive it. For 
example, paste the See Also button into all of the procedure topics. 

8. Apply the See Also style to the button. 

Note: You must compile WebHelp to test the See Also button. 
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Creating See Also Keywords 

 
Procedure 
 
To create a See Also keyword: 

1. Click the Index tab. 
2. In the top-left corner of the Index tab, click See Also from the list. 
3. In the box next to the list, type the name of the See Also keyword, and then 

click Add. The See Also keyword appears in the top section of the Index 
tab. 

 
 

Note: The See Also keyword appears in bold until you add a topic to it. 
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4. Click the Topics tab. Topic names appear in the right pane. 



5. Drag and drop the topics that you want to link to the keyword into the Topics 
for pane. The See Also keyword is created and you can now create the 
Creating See Also Buttons button. 
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Note: Include the relevant About, Business Policy, and Process Flow topics. Also 
include related procedural topics, including shared topics. Not every topic in the book 
may be related. 



RoboHelp Styles 

Overview 

This topic describes the RoboHelp styles used in Information Design templates. 

Style Descriptions (are these still the same?) 

Style Description 
Heading 1 Use for the topic title. 
Heading 2 Use to designate the following sections: 

 Overview 
 Rules 
 Guidelines 
 Procedure 

Heading 3 Use for the infinitive phrase and 
subtopics within a Heading 2 section. 

Normal Use this style for text. 
DocTitle1 Use for the company or division name in 

the header. 
Use for the department name in the 
header. 

DocTitle2 

Note Note: Use for information that appears 
in the middle of a procedure. 

GlossTerm  
Heading Table Use for table headings. 

Seealso Used to format the paragraph that 
contains the See Also button. 

SummaryHeadingTable Use for Book Summary table headings. 
Bold Obsolete style. May have been used in 

some projects to apply bold formatting to 
text. Instead of using this style when 
text should appear in boldfaced font, use 
the Apply Bold button on the Formatting 
toolbar. 

Glossary text Apply this style to the link text leading to 
a glossary term. 

Image link Use to link an image to a button, tab, 
field, or window name (see Using the 
ImageLink Style). 

YellowHighlight Use to indicate new or revised text. 
Apply the "Default paragraph font" style 
to remove the YellowHighlight style. 
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Starting Projects with the Model Project 

Procedure 

To start a RoboHelp project: 

1. Start RoboHelp. The RoboHelp HTML window opens automatically. 
2. Click Create a new project. The New Project window opens. 
3. In Help Project Type, ensure that WebHelp is selected, and then click OK. 

The New Project Wizard opens. 
4. Type the appropriate information into the following fields: 

 Project title 
 Project file name 
 Location of the project 
 Title of first topic 

5. Select the Enable WebSearch check box if it is not selected. 
6. Click Finish. The main RoboHelp window opens. 
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Creating a New RoboHelp Project 

Procedure 

To Start a RoboHelp project: 

1. Start RoboHelp. The RoboHelp HTML opens automatically. 
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2. On the File menu, click New > WebHelp. The New Project Wizard opens. 

 

3. In Project Type select WebHelp, and click OK. The New Project Wizard 
opens. 
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4. Type the appropriate information into the following fields: 

 Project title 
 Project file name 
 Location of the project 
 Title of the first topic 

5. Select the Enable WebSearch checkbox if it is not selected. 
6. Click Finish. The main RoboHelp window opens. 

 
 
Symbols 
 

Ampersands 

 
 
Rules 

 It is acceptable to use an ampersand (&) if it is part of a company's official 
name or part of a trade name. 

 Do not use an ampersand in place of the word and in most other contexts. 

Correct 

Town & Country Credit Corporation 

Press the & key. 

Incorrect 

Open the file & follow the directions. 

Copyright 
 

Overview 

A copyright is the exclusive right to prohibit unauthorized publication, production, or 
sale of a literary, dramatic, musical, or other artistic work. 

Copyright notices are established to protect published work from infringement by 
persons or entities other than the original author and publisher. 

Under U.S. copyright law, a valid copyright notice generally consists of three 
elements: 

 © symbol, the word Copyright, or the abbreviation Copr. 
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 Year of first publication of the work 



 Name of the copyright owner, a recognizable abbreviation, or generally known 
alternative designation 

 
Rules 

 When placing a copyright in text, use the © key. Do not spell out the word. 
 It is the publisher's responsibility to place copyright notices on published 

work. Do not place a copyright symbol in proximity to published work by 
another author. 

Using Copyrighted Material 

 Under the doctrine of fair use—the licit employment of copyrighted 
material—others may copy brief portions of a copyrighted work for certain 
purposes without obtaining written permission from the publisher. When using 
copyrighted material, accurately transcribe the text and give credit to the 
sources. 

 Reference the exact source of the material in a note or internal reference in 
the text, in a source note to a table or in a credit line with an illustration. 

 The term brief refers to the amount of material in relation to the entire 
document—to quote 500 words from an essay of 5,000 is considered more 
serious than the same number of words from a work of 50,000. 

 When the amount or nature of the quoted material is considered to be more 
substantial, obtain permission from the publisher before printing the material. 

 
Guidelines 
 

Although the law does not define the exact limits of fair use, factors to consider 
include the following: 

 The purpose of the use: nonprofit or educational purposes are judged by 
more lenient standards than commercial use 

 The nature of the copyrighted work: highly technical or fact-based material is 
judged by stricter standards than fiction 

 The amount and substantiality of the portion used in relation to the 
copyrighted work as a whole 

 The effect of the use upon the potential market for, or value of, the 
copyrighted work. 
 

Percentages 

Overview 
 
Percent means per hundred; percentage means a proportion or share in relation to 
a whole. See the Percentages and Fractions topic for information on using 
numerals with percentages. 
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Rules 

 Whenever possible, use the % key instead of typing the word percent. 
 Do not use the % key in place of the word percentage. 

Correct 

Sales for the quarter rose by 43%. 

The percentage of bad loans compared to total equity is low. 

Use the chart to compare percentages of income levels to population density. 

System Input 

 When instructing a user to type a symbol key, use the name of the key, 
stated in title case. For symbol keys that are not named (such as the % key), 
use the symbol. 

Correct 

At the screen prompt, type 41% (use the % key). 

Incorrect 

At the screen prompt, type 41% (use the Percent key). 

Symbols in Text 

 
 
Rules 

 When referencing symbols, use the actual symbol rather than typing the 
name of the symbol. 

 When instructing a user to type a symbol key, state the name of the key in 
title case. 

 For symbol keys that are not named (such as the % key), use the symbol. 

Correct 

Press the & key. 

Press the % key. 

Incorrect 

Press the Ampersand key. 
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Press the Percent key. 



 
Trademarks and Service Marks 

Overview 

A trademark is a symbol, design, logo, word, letter, motto, slogan, or the like used 
by a business to distinguish itself or its products from its competitors. Trademarks 
are used to identify products by trade name and to distinguish them from those of 
competitors. 

A registered trademark consists of at least one of the following: 

 The symbol ®, the words trademark, registered trademark, or the 
abbreviation reg. 

 The proprietary name, capitalized and enclosed within parentheses. (Arm & 
Hammer) 

A service mark symbol is a design, word, letter, or slogan used by a supplier of a 
service to distinguish the service from that of a competitor. Service marks are 
usually registered and protected by law; they often accompany the word 
Trademark. 
 

Rules 

 Whenever possible, use service mark symbols provided by the supplier; do 
not attempt to duplicate service mark symbols by drawing them. 

 Never represent a protected service as one's own; instead, credit the original 
service provider. 

 Whenever possible, use the ® symbol. Do not spell out the word. 
 When referring to registered trademark as an explanatory or descriptive 

term, use lowercase. 
 Use title case when the term appears in a title or heading. 
 Do not confuse trade names with generic products or processes. 
 Be aware that the term Realtor is a trademark. It denotes a member of the 

National Association of Realtors. Use "real estate agent" when referring to 
persons who represent buyers and sellers in a real estate transaction. 

Correct 

IBM, PC-DOS, OS/2, are registered trademarks of the IBM corporation. 

Used in a Heading: RoboHelp is a Registered Trademark of Adobe Systems, 
Inc. 

Please photocopy this document. 

Incorrect 

IBM, PC-DOS, OS/2, are Registered Trademarks of the IBM corporation. 
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Please Xerox this document. 



 

 
Tables 

About Tables 

Overview 

A table is an arrangement of data with two or more rows and two or more columns. 
Usually, the information in the first column describes something whose attributes are 
shown in the other columns. 

A table usually has column headings, and it can optionally have a title. 

Note: A list of similar entries that is arranged in multiple columns is not a table but a 
Multicolumn Lists, for example, a list of commands. 

Rules 

 Introduce tables with a sentence ending with a period. 
 If a table is titled, an introductory sentence does not need to precede the 

table. 
 Tables for on-screen display should follow the same guidelines as tables in 

other content. Keep in mind these additional points, however: 

 Table dimensions must be visible on a minimum screen resolution, usually 
800 × 600 pixels. 

 Tables can be used to simulate frames. In this case, tables are better 
because older browsers cannot always process frames correctly. 

Capitalization and Punctuation in Tables 

 
 
Rules 

 If the table is titled, use title caps for the title. That is, do not capitalize 
articles, prepositions of four or fewer letters, or coordinating conjunctions. 

 Title cap each column heading. 
 Initial cap the first word of each column entry and proper nouns. 
 It is acceptable to use lowercase for the first word in column entries if 

capitalization might cause confusion; for example, keywords that must be 
lowercase. 

 End each entry with a period if all entries are complete sentences or are a 
mixture of fragments and sentences. An exception is when all entries are 
short imperative sentences (only a few words); such entries do not need a 
period. 

 If all entries are fragments, do not end them with periods. 
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Column Headings in Tables 

 
 
Rules 

 
 
Rules 

 Make column headings as concise as possible, but include information 
common to all column entries in the heading, rather than repeat it in each 
entry. 

 Make column headings as concise as possible, but include information 
common to all column entries in the heading, rather than repeat it in each 
entry. 

 Use a table to display if/then information. Use ellipses in column headings.  Use a table to display if/then information. Use ellipses in column headings. 

Note: In RoboHelp, insert ellipses by clicking the Insert menu, then clicking 
Symbol. 
Note: In RoboHelp, insert ellipses by clicking the Insert menu, then clicking 
Symbol. 

Correct Correct 

To Do This 
Open a Web page In the Address bar, type the address, 

and then press Enter. 
Add a Web page to the favorites list Click Favorites, and then click Add to 

Favorites. 

 

To Save a Document Do This 
Click Save. To a folder 

Under a new name Click Save As. 
To a network location Connect to the server location and folder, 

and then click Save. 

 

If the Check… Then… 
Contains a return address Return the check to the sender. 
Does not contain an address Shred the check. 

 

To Do This 
Close a window Click the Minimize button. 
Size a window Press Ctrl+F8. 
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Content in Tables 

 
Rules 

 Tables read across from left to right. That is, content in the left column should 
relate logically and horizontally to the information in adjacent columns. 
Column headings should reflect this logical flow. 

 Place information that is known or obvious to the user in the leftmost 
column of the table. Place information that the user is to learn or an action 
the user is to perform in subsequent columns. 

 Make entries in a table parallel, as in lists; for example, in a description or 
action column, be consistent by starting the entries with a verb or noun. 

 When field names appear in a Field/Action table, do not format the field name 
in bold. However, when the steps refer to field names, buttons, and so on, 
use bold. 

Correct 

Device Name Description 
COM1 Serial port 1; the first serial port in the 

computer. 
CON System console; consists of both the 

keyboard and the screen. 
LPT1 Parallel port 1; represents a parallel 

port. 

 

Field Action 
Transfer ID Accept the default value. 
Transfer Type Select External Transfer. 

 Do not leave a blank column entry. That is, if the information does not apply, 
type N/A or None. Do not use em dashes. 

Correct 

In Windows On the MacIntosh  To 
Copy a picture Right-click + Copy Command+Shift+T 

 Do not use footnotes in tables; place the information in an Information-style 
bullet after the table. 

Table Formatting 
 

Overview 
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Most table formatting is provided by the Standard HTML table format (see Using the 
Standard Table Format). The guidelines in this topic suggest ways to make tables 
more readable. 



 
Rules 

 Avoid dividing a table between pages. If a titled table is continued on another 
page, repeat its column headings. 

 If a table is very long, consider breaking the material into logically related 
subtables. 

 Use rules between rows if the column information varies. 
 Do not use boldfaced text for field names used in tables. 
 Apply the HeadingTable style to the table header row. 
 Try to limit tables with long entries to two or three columns. Four or more 

columns can be hard to format and read unless they contain brief, numeric 
entries. The second column in the following example is approaching 
maximum readable length. 

Correct 

Addressing Declared with Microsoft Keywords 

Data  Code Arithmetic Keyword  
_ _near Data resides in the 

default data 
segment; addresses 
are 16 bits. 

Functions reside in 
the current code 
segment; addresses 
are 16 bits. 

16 bits 

_ _far Data can be 
anywhere in 
memory, not 
necessarily in the 
default data 
segment; addresses 
are 32 bits. 

Functions can be 
called from 
anywhere in 
memory; addresses 
are 32 bits. 

16 bits 

_ _huge Data can be 
anywhere in 
memory, not 
necessarily in the 
default data 
segment. Individual 
data items (arrays) 
can exceed 64K in 
size; addresses are 
32 bits. 

 

Not applicable; code 
cannot be declared 
_ _huge. 

32 bits (data only) 
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Table Numbering 

 
 
Rules 

 Do not number tables in online documentation; tables are generally in 
the same area as the related content, and therefore do not need to be 
numbered. 

 Number tables in printed documents if they are not adjacent to the text 
reference or if a list of tables appears in the front matter. 

 If it is necessary to number tables in printed documents, use numbers 
consistently throughout the document. The numbers should include the 
chapter number and a sequential table number, such as Table 2.1, Table 
2.2, and Table 2.3. 

 
Acronyms 

The following table displays Data Trace acronyms. 

Term Definition 
AP All posting 
AML's Adjustable Mortgage Loans 
A & R Assignment and Release 
ALTA American Land Title Association 
AMD Amendment 

Assessor's Parcel Number (for property 
tax).  The APN is the number by which 
property taxes are referenced. When you 
search for a title by APN, the system 
does a cross-reference title search by 
APN. The cross reference is invisible to 
the user as the title search results are 
then displayed. Usually a title search is 
done by legal (land) description such as 
by parcel, block, lot, subdivision, section, 
arb, or map book or page number, etc. 

APN 

APS Assessor Parcel Number 
ARB Arbitrary. Large tracts portions of which 

have been sold without the recordation of 
a subdivision map, carried as a lot in the 
company account.  

AS Assignment  
ASD Assessed 
ASM Assumption 
ASN Assignment 
BND Bond 
BUQA Business Unit Quality Assurance 
CC&R Covenants, Conditions and Restrictions 
CCB Change Control Board 
CS County Specific 
CSR 
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Customer Service Rep 



DIS Disclaimer 
DOT Deed of Trust 
DTS Data Trace System (First American Real 

Estate Solutions) 
FIC CCB in India 
ICP Ideas Changes Problems. Used to track 

needed new features, fixes or 
improvements needed. 

IMP Improvements 
IST India Standard Time 
LP/LLC  Inquiry on Limited Partnership and 

Limited Liability Corporations. 
MLN Mechanic’s Lien 
MOD Modification 
MTG Mortgage 
NL No Listing 
OFM Order File Management 
OO  Office Information 
P Plant 
PIQ Property in Question 
PITI Principal, Interest, Taxes, and Insurance 

payments 
PRL Partial Release 
R & R Releases and Reconveyances 
RAT Ratification 
RC Reconveyance 
REL Release 
RL  Release 
SAP  Suppress Adjacent Property (Starters). 

Will not see adjoining lots for base 
SAT Suppress All Tract Searches 
SDX Soundex 
SITUS Physical location 
SOS Secretary of State in California. The 

California SOS maintains records 
regarding status, officers, and legal 
entities involved with a corporation, 
limited partnership, or a notary. 

SR Starter Record 
STS Smart Title Solutions 
SUB Subordination 
SX Starter Exchange Program 
T Tax 
TD Trust Deed 
TEE Grantee 
TIPS Title Integrated Property Services 
TOF Title Officer 
TOR Grantor 
TRT Tax Rate Table 
TT  Title Officer, or TeleTitle System (Group 

2) 
UCC 
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Uniform Commercial Code 



XGR Agreement 
 
 
Glossary 
 

access 

 
Avoid using as a verb; try to find a substitute, such as open. 

affect, effect 

 
Affect is usually a verb meaning to influence. Effect is usually a noun meaning a 
result.  

Correct 
Late software can adversely affect schedules. 
One adverse effect of late software is schedule slippage. 

Incorrect 
He was hoping the affect would be minimal. 

Hint 
Affect means to cAuse, so it has an a.  
Effect means the rEsult, so it has an e. 

allonge 

Written documentation of an endorsement of a Promissory Note or a Lost Note 
Affidavit. It is attached to the document being endorsed and is generally used when 
no room is available for the endorsement on the underlying document or it would be 
more efficient than placing the endorsement directly on the related document. 

among, between 

Use between for only two items; use among when referring to more than two.a 
Correct 
The difference between the two versions is significant. 
Divide the tasks equally among the four team members. 

Incorrect 
The main difference among the two versions is that the newer one is faster. 
The tasks should be divided equally between the four team members. 

and/or 

According to The Little, Brown Handbook, and/or indicates three options: one or 
the other or both. If you mean all three options, and/or is appropriate. Otherwise, 
use and if you mean both; use or if you mean either. 
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Correct 
Obtain a telephone number and/or an email address. (Obtain a telephone number or 



an email address or both.) 
Obtain a telephone number and an email address. (Obtain both.) 
Obtain a telephone number or an email address. (Obtain either one.) 

appear, display 

 Appear is an intransitive verb. (It does not require a direct object.) 
 Display is a transitive verb. (It requires an object.) 
 If necessary in context, the passive is displayed is acceptable. 
 Prefer opens to appears when referring to windows and screens. 

Correct 
If the user attempts to quit the program without saving the file, a message appears. 
The screen displays a message if the user does not log on accurately. 
A message is displayed if the user does not log on accurately. 
On the Tools menu, click Options. The Options window opens. 

Incorrect 
If the user attempts to quit the program without saving the file, a message 
displays. 

appraise, apprise 

To appraise means "to set a value on something," but it is often confused with to 
apprise (of), "to notify or inform." 

approval levels 

In Loan Origination/Loan Operations documentation, do not capitalize or hyphenate 
approval authority levels. 

Correct 
A level 4 approval is required to remove the stipulation. 
Incorrect 
A Level-4 approval is required to remove the stipulation. 

articles 

 
The words a, an, and the. 

as, because, since   

 
 Avoid using as and since to mean because. 
 Use because to refer to a reason. 
 Use since to refer to a passage of time.  

Correct 
The system is more stable because we installed a new server. 
Since the new server was installed, user access has increased by 20% in just two 
weeks. 
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Incorrect 
He couldn't hear the ambulance siren as he was listening to the car radio. 



The system is more stable since we installed the new server. 
We cannot do this since it's against the rules.  

as, like 

  Like is acceptable as a synonym for such as or similar to. 
 Do not use like as a conjunction; use as instead. 

Correct 
In a workgroup, the user can work with files residing on another computer as he 
would on his own. 
Moving a toolbar is like moving a window. 

Incorrect 
In a workgroup, the user can work with files residing on another computer like he 
would on his own. 
Always use the technical writing style, like you would in a user manual. 

assure, ensure, insure 
 

 To assure is to confidently inform. 
 To ensure is to make sure of something. 
 To insure is to take out an insurance policy 

 

auto-populate 
 

Avoid using the term auto-populate to describe system behavior. Instead, use 
another phrase, such as automatically populate. 

Correct 
Some of the topics in the Topic list contain templates that automatically populate 
the Message field. 

Incorrect 
Some of the topics in the Topic list contain templates that auto-populate the 
Message field. 

back up, backup 
 

 To back up [two words] means to take action; use it only as a verb. 
 Use backup [one word] only as a noun or an adjective; do not use it as a 

verb. 
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Correct 
Back up the files before turning off the computer. (verb) 
Save the backup to the network directory. (noun) 
Create backup files for off-site storage. (adjective) 



Incorrect 
Backup the files before turning off the computer. 
Save the back up to the network directory. 

books 

 
In RoboHelp, a book is a group of related topics under a book icon. A book can 
comprise a book summary topic, an "about" topic, a business policy topic, a process 
flow topic, one or more procedure topics, and sometimes, document pages. 

calendar 

Do not use as a verb; instead, use schedule, list, or another appropriate verb. 

Correct 
Mark the calendar for the upcoming event. 
Schedule the event for next Tuesday. 

Incorrect 
Let's calendar the event for next Tuesday. 

can, may, might 

 Use the verb can to describe actions or tasks that a user or program is 
capable of doing. 

 Use may or might to express a possible outcome, or when the result of an 
action is unknown or variable 

 Use may in the sense of having permission to do something. 
 In general, avoid could; it’s seldom necessary. 

Correct 
He can use a spreadsheet to perform the calculations. 
Because of her security clearance, she may access the primary server. 
He might use a buy-down option to lower his initial monthly payments 
If the project is ahead of schedule, they might be allowed to leave early. 

Incorrect 
He may use a spreadsheet to perform the calculations. 
If the project is ahead of schedule, they could be allowed to leave early. 

cancel, cancelled, canceling, cancellation 

This topic describes the spelling of cancel, canceled, canceling, and cancellation as 
used in the United States. British usage is different. 

 Spell the verbs cancel and canceled and the gerund canceling with only 
one l. 

 Spell the noun cancellation with two l's. 
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Correct 
Please cancel that request. 
The meeting was canceled. 



She's thinking about canceling the appointment. 
The cancellation of the meeting was unexpected. 

cardinal numbers 

 
Numbers that express amount, such as one, two, and three. 
 

cascading menu 

 
According to the Microsoft Manual of Style for Technical Publications, a 
cascading menu (or submenu) is the secondary menu that appears when the user 
selects a command that includes a small arrow on the right. 
 

cc: 

 the term cc: is used to identify a copy of an email message. 
 The term cc: may be used as a verb. 
 Type cc: with two lowercase letters followed by a colon. 
 Instead of beginning a sentence with cc:, use another word. 
 The acronym cc: does not need to be spelled out. 
 Correct 
 Email the request to the vendor and cc: the team lead. 
 Send a copy to the account representative. 
 Incorrect 
 Email the request to the vendor and CC (carbon copy) the team lead. 
 cc: the account representative. 

clause 

A sequence of related words within a sentence. A clause has both a subject and a 
predicate and functions either as an independent unit (main clause) or as a 
dependent unit (subordinate clause, used as an adverb, an adjective, or a noun). 
 

common nouns 

Nouns that name general classes of people, places, and things. 
Examples: a nun, a city, a freeway 

compound adjectives 

 
Page 99 of 119 

A combination of words (of whatever parts of speech) that function as a single 
adjectival unit (drop-down menu, pop-up window, owner-occupied property, 
third-party authorization). Most, but not all, compound adjectives use hyphens to 
separate their individual elements. 



comprise, compose 

Comprise, according to the Elements of Style, means "embrace": A zoo comprises 
mammals, reptiles, and birds (because it "embraces," or "includes," them). But 
animals do not comprise ("embrace") a zoo—they constitute a zoo. 

Another way to think about comprise is that it is the whole, and what it includes are 
the parts. 

Do not use comprise with the preposition of; use composed instead, as in 
composed of. 

Correct 
The Legal Group comprises six departments. 
The Legal Group is composed of six departments. 

Incorrect 
The Legal Group is comprised of six departments. 

coordinating conjunctions 

Conjunctions connect other words or groups of words to one another. Coordinating 
conjunctions join equivalent structures—two or more nouns, pronouns, verbs, 
adjectives, adverbs, prepositions, conjunctions, phrases, or clauses. (The 
conjunctions nor, for, and so can connect independent clauses only.) 

Examples 
and, but, or, nor, for, so, yet 

data 

Data is now commonly accepted in business and technical writing with a singular 
verb. ("The data is available.") Use singular verbs with data in IDD information 
products. 

In academic writing, it is still necessary (and correct) to use a plural verb for this 
plural Latin term. 

different 

 When following a number, different is often superfluous; delete it in these cases. 

Correct 
The loan coordinator processed 30 loans today. 
 
Incorrect 
The loan coordinator processed 30 different loans today. 
 

done, finished 
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Do not use when you are done; use when finished instead. 



Correct 
When finished with the editing, print the file. 

Incorrect 
When done, print the file. 

email 
 

 Use email to refer to an electronic mail program, as in send the file using 
email, but use email messages, or just messages or notes, to refer to 
pieces of email. 

 It may be used as a verb, as in email the file. 
 Do not capitalize the e in email. Use Email only at the beginning of a 

sentence and in headings. 

em dash 

A mark of punctuation used to mark a break in thought, to set off a parenthetical 
element for emphasis or clarity, and to set off an introductory series. A dash is equal 
to the width of an uppercase M in the font style being used. Use dashes sparingly 
and not as easy or automatic substitutes for commas, semicolons, or end marks. 

Note: In RoboHelp, insert an em dash or en dash by clicking the Insert menu, then 
clicking Symbol. 

en dash 

 A mark of punctuation used with sets of numerals, letters, or a combination of both; 
exceptions include numbered designations of aircraft (DC-10) and highways (I-15), 
which use hyphens. An en dash is half the width of an em dash and longer than a 
hyphen. 

Note: In RoboHelp, insert an en dash or em dash by clicking the Insert menu, then 
clicking Symbol. 

enter, type 

 Use type to describe what users type in a screen, window, or page. 
 An exception to this rule applies when documenting a combo box. It is 

acceptable to tell users to enter a choice when they can either type a value 
or select one from a list. 

 Use a combination of words such as type or select if space is not an issue. 

Correct 
Type the password. 
Enter the file name. (only when describing a combo box) 
Type the path to the server or select it from the list. (only when describing a combo 
box) 
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Incorrect 
Enter the password. 



entitled, titled 

 Do not use entitled as a synonym for titled. 
 Entitled implies that someone is owed something. 
 To specify the name of a book, program or similar item, use the word titled 

instead of entitled. 
 The word titled is not followed by a comma. 

Correct 
Look in the manual titled User's Guide. 
The user is entitled to a set of documentation. 

Incorrect 
Look in the manual, entitled User's Guide. 
Look in the manual titled, User's Guide. 

etc. 

Do not use. Instead, write and so forth or and so on. 

fax, facsimile 
 

 Do not use facsimile to refer to the kind of document sent through a fax 
machine; use fax instead. 

 Use facsimile only to refer to an exact reproduction of something else. 
 Use fax as a noun, adjective, or verb. 
 Do not use FAX in all caps. 

Correct 
The fax arrived. (noun) 
The fax machine was broken, so the fax transmission did not arrive. (adjectives) 
Please fax a copy of the order to the client. (verb) 
He faxed the order yesterday. (verb) 

Incorrect 
Please FAX me a copy of the order. 
He FAXed the order yesterday. 

fewer, less, under 
 

 Use less to refer to a mass amount, value, or degree. 
 Use fewer to refer to a countable number of items. (But see the exception.) 
 Do not use under to refer to a quantity or number. 

Correct 
The new building has less floor space and contains fewer offices. 
Fewer than 75 members were present. 
Less than a quorum attended. 
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Incorrect 
Less than 75 members were present. 



The new building has less offices. 
Under 75 members attended. 
The new building has under 10 floors. 

Exception 
Using the XYZ system, you can order and receive loan history information online in 
24 hours or less. 

(In this exception example, although hours are countable, less is appropriate 
because "24 hours or less" can be regarded as a single entity.) 

file names 

The external names of files. Use two words. Can be used as an adjective or a noun. 

following 

 Use following to introduce art, a table, procedures or, in some cases, a list. 
 If following is the last word before what it introduces, follow it with a colon. 

Correct 
The following table compares several rates. 
To install the program, do the following: 

Incorrect 
The table below compares several rates. 
To install the program, do the following. 

gerund 
 
A verbal (nonfinite verb) ending in -ing that functions as a noun. 

grow 
 
Jargon; do not use (unless you are describing vegetables). 
 
Correct 
Sally plans to grow squash and beans in her garden. 

Incorrect 
The CEO hopes to grow the business in the future. 

if, whether 

 Use if for uncertainties or conditionals. 
 Use when for situations requiring preparation or the passage of time. 
 Use whether for one or more alternative possibilities or situations. 
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Correct 
The printer might insert stray characters if the wrong font cartridge is selected. 
If the document will not print… 



Incorrect 
The printer might insert stray characters when the wrong font cartridge is selected. 
To find out if TrueType fonts are available… 
When the document will not print… 
If the document is ready to print… 

impact 

 Do not use as a verb—it’s jargon. Use affect or another synonym instead. 

Correct 
Sending an inappropriate email message can adversely affect a person's career. 

Incorrect 
Sending an inappropriate email message can adversely impact a person's career. 

in order to 

 In order to is verbose; just use to instead. 

Correct 
To open the program, click File, Open. 

Incorrect 
In order to open the program, click File, Open. 

inbox 

In Outlook, a folder in which incoming messages are stored. As a physical entity, a 
tray, basket, or similar item used to hold incoming letters, messages, or documents. 
Use one word. 

infinitive phrase 

In procedure topics, a phrase that begins with "to" and ends with a colon. It 
introduces a set of steps that accomplish a task, and restates the topic title in 
singular form. A single procedure topic may have multiple related tasks and 
therefore multiple infinitive phrases. An example of an infinitive phrase for a topic 
named "Processing Western Union Payments," is To process a Western Union 
payment: 

in, into 

 In indicates within the limits, bounds, or area of a place or object. 
 Into implies moving from the outside to the interior of a place or object. 
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Correct 
A word is in a paragraph, but text is moved into a document. 
Data is in the cell of a worksheet. 



A file name is in a list box. 
A workstation is in a domain, but resources are on servers. 
Edit the cell contents in the formula bar. 
Open multiple windows in a document. 
Insert the disk into a disk drive. 
Programs run with, on or under an operating system, not in them. 
Data is in a field, on a window. 

input 

 Avoid using as a verb; use type instead. 

Correct 
Type new text to correct the original. 
Their input was very helpful. 

Incorrect 
Input new text to correct the original. 

Internet, intranet 

The term Internet (capitalized) refers to the worldwide collection of networks that 
use TCP/IP (Transmission Control Protocol/Internet Protocol) to communicate with 
one another. The Internet offers a number of tools, including email, the World Wide 
Web, and other communication services. 

The term internet (lowercase) refers to any large network made up of a number of 
smaller networks. 

 In general, avoid use of the lowercase term or define it so that it is not 
confused with the Internet. 

intranet 

An intranet (lowercase) is a communications network based on the same technology 
as the World Wide Web, but it is available only to certain people, such as the 
employees of a company. 

Correct 
Log on to the Internet to find the Web site. 
The information can be found on the company's intranet. 

Incorrect 
Log onto the internet to find the Web site. 
The information can be found on the company's Intranet. 

irregardless 

Should be regardless. 
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Correct 
Regardless of the consequences, they continued on course. 



Incorrect 
Irregardless of the consequences, they continued on course. 

its, it’s 

 Differentiate between the contraction it’s (it is) and the possessive pronoun 
its. 

 Never use an apostrophe with possessive pronouns (not their’s) or to denote 
the plural of a singular noun. 

Correct 
It’s easy to take advantage of many new features in the software. 
The easy connection to other systems is just one of its many advantages. 
The software is theirs. 

Incorrect 
The software is their's. 
Its important to follow the rules. 

judgment 

 This word is often misspelled. 

Correct 
judgment 
Incorrect 
judgement 

matrix, matrices 

Note the spelling of the plural form. 

Correct 
The matrix consists of questions and answers. 
All of the matrices are aligned. 

Incorrect 
All of the matrixes are aligned. (While grammatically correct, this term is 
nonstandard and seldom used; it is also more cumbersome and awkward than 
matrices.) 

more than, over 

 Use more than to refer to quantifiable figures and amounts. 

Correct 
The company funded more than 18,000 loans last month. 
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Incorrect 
The company funded over 18,000 loans last month. 



 Use over to refer to a spatial relationship or position or in a comparison in 
which more is already used. 

Correct 
After you compress your drive, your disk will have over 50 percent more free space. 

multicolumn lists 

 
Lists of similar entries arranged in multiple columns. While a multicolumn list has the 
appearance of a table, it is not a table. 

nonpublic personal information 

Nonpublic personal information (NPI) consists of combinations of the following: 

 Name 
 Address 
 Bank account number 
 Credit or debit card number 
 Driver's license or state ID card number 
 Education 
 Employment history 
 Passport number 
 Physical characteristics or description 
 Signature 
 Social Security number 
 Telephone number 

off, off of 

Do not use of after another preposition; for example, off of or outside of. 

Correct 
The taskbar is outside the main window area. 
Save the file, and then log off the network. 

Incorrect 
The taskbar is outside of the main window area. 
Save the file, and then log off of the network. 

offline 

 
Offline is one word in all instances; do not hyphenate it. 

off-site 

 
Hyphenate 
 

on 
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 Use on with the following Windows elements: 



 Menus (the Open command is on the File menu) 
 Taskbar, toolbar, ruler, and desktop (click Start on the taskbar) 
 Windows (The View tab is located on the Options window.) 
 Disks, in the sense of a program being on a disk 
 Interface (it can be seen on the user interface) 
 A computer screen (the window appears on the screen) 
 Network (The printer is on the network.) 
 Data is in a field, on a window 

Correct 
Click the right mouse button. 
Click the WordPad icon. 
Click OK. 
Press Enter. 

Incorrect 
Click on the right mouse button. 
Click on the WordPad icon. 
Click on OK. 
Press on the Enter key. 

once 

  To avoid ambiguity, do not use as a synonym for after. 

Correct 
After you save the document, you can quit the program. 

Incorrect 
Once you save the document, you can quit the program. 

online 

 Online is one word in all instances; do not hyphenate it. 
 Online is worth avoiding much of the time because it can be interpreted 

ambiguously. Online is now generally understood to refer to the Internet, but 
in such contexts it is better to be specific. It is also used to refer to data that 
resides on a computer. If you must use online, especially in the sense of data 
that resides on a computer, be explicit about your meaning so that your 
readers cannot misunderstand you. 

Preferable 
Many support services are available on the World Wide Web. 
Many products include documentation on the CDs in the package. 

Acceptable 
Many support services are available online. 
Many products include online documentation on the CDs in the package. 
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Incorrect 
Many products include online documentation. 



on-site 

Hyphenate. An adverb meaning "accomplished or located at the site of a particular 
activity or concern." 

onto, on to 

 Use two words (on to) for the action of connecting to a network. 
 Use one word (onto) to indicate moving something to a position on top of 

something else. 

Correct 
Log on to the network. 
Drag the icon onto the desktop. 

Incorrect 
Log onto the network. 
Drag the icon on the desktop. 

ordered lists 

Lists that have a sequence or order. 

For vertical ordered lists, use Arabic numerals with periods for the first level, 
lowercase letters with periods for the second level, and lowercase Roman numerals 
with periods for the third level. Avoid third-level ordered lists whenever possible by 
rewriting the material. 

ordinal numbers 

Numbers that express degree, quality, or position in a series, such as first, second, 
and third. 

parenthetical plurals 

Plural forms of words created by typing (s) or (es). These much-criticized 
constructions are hard to read and, in many cases, present subject-and-verb 
agreement problems. 

Correct 
Provide full addresses and telephone numbers for all applicants. 

Incorrect 
Provide full address(es) and telephone number(s) for all applicants. 

prepositions 

Important structural words that express relationships—in space, time, or other 
senses—between nouns or pronouns and other words in a sentence. 
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Examples: about, above, across, after, against, along, among, around, as, at, 
below, before, behind, beneath, beside, between, beyond, by, down, during, except, 



for, from, in, inside, into, like, near, of, off, on, onto, out, over, past, regarding, 
since, through, toward, under, until, up, with, without. 

preventative, prevent 

 Preventative, while grammatically correct, is longer and more cumbersome 
than preventive. 

 Preventitive is never correct. 

Correct 
It was necessary to take preventive measures. 
Take the necessary preventive measures to protect the file. 

Incorrect 
Take the necessary preventative measures to protect the file. 

principal, principle 

Distinguish between principal, an adjective or noun meaning "chief" or "chief 
official," and the noun principle, meaning "fundamental truth." 

proper adjectives 

Adjectives formed from proper nouns. 

Examples: Brazilian, Orwellian, Hellenic 

proper nouns 

Nouns that name specific persons, places, and things. 

Examples: Mother Teresa, San Francisco, the San Diego Freeway 

screenshot 

Use this name (one word) for a screen or window image, instead of "screen 
capture" or "screen example." 

sentence-style capitalization 

In this style of capitalization ("sentence caps" or "sentence case") only the first word 
in a title, the first word in a subtitle, and any proper names are capitalized. 

serial comma 

The comma in a list of more than two items that separates the last item from the 
next-to-last item. Also called the series comma, Oxford comma, and Harvard 
comma. Data Trace uses the serial comma. 

Examples 
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The manager, supervisor, or team leader reviews the draft. 



slashed constructions 

A writing shortcut that combines two or more words or phrases with slashes and 
results in diminished clarity for the reader. Do not use this technique. Separate the 
words or phrases with conjunctions (and, or) or use another method to explain the 
relationship between or among the parts. See Slash for correct and incorrect usage 
examples. 

Exceptions: 

 The terms read/write and input/output are well-established in the 
information systems field in slashed form. (Note, however, that read-only is 
always hyphenated.) 

 The term and/or is acceptable. 

Social Security number 

Describe as Social Security number (small "n" for number). The acronym is SSN (all 
caps). 

that, which 

 Use that with a restrictive clause—a clause absolutely necessary to the 
sentence. 

 Use which with a nonrestrictive clause—a clause that adds descriptive 
matter, but is not necessary to the sentence. 

 Use a comma before the word which. 

Correct 
This is the project that will launch his career. 
He was glad that they understood his point. 
Use the instructions that came with the program. 
The executive committee, which is made up of vice presidents, has not discussed 
the problem. 
The report was not ready, which was disappointing. 

Incorrect 
This is the project which will launch his career. 
Use the instructions which came with the program. 
The executive committee, that is made up of vice presidents, has not discussed the 
problem. 

that, who 

When referring to people, use who or whom; use that for references to places or 
things. 
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Correct 
Custom Setup is for experienced users who want to alter the standard configuration. 
That is the software that was ordered last week. 



Incorrect 
Custom Setup is for experienced users that want to alter the standard configuration. 
Everyone that is interested should attend. 
Custom Setup is for experienced users whom want to alter the standard 
configuration. 

their, them 

Avoid using the plural form for named or homogeneous groups (collective nouns). 

Correct 
The Legal Department revised its procedures. 
The executive council made its concerns known. 

Incorrect 
The Legal Department revised their procedures. 
He assured the council that their concerns were unfounded. 

then 

 Then is not a coordinating conjunction and thus cannot correctly join two 
independent clauses. Use and or another coordinating conjunction to connect 
independent clauses, especially in a two-part procedural step. 

 Introduce the final clause of a two-part procedural step with a comma (not a 
semicolon) and the words and then. 

Correct 
On the File menu click Save As, and then type the name of the file. 

Incorrect 
On the File menu, click Save As; then type the name of the file. 

 Avoid using then to introduce a subordinate clause that follows an if clause 
(an “if…then” construction). 

Correct 
If the new software arrives on time, we will have it installed by Friday. 

Incorrect 
If the new software arrives on time, then we will have it installed by Friday. 

third party vs. third-party 

 Hyphenate third-party when the term is used as a compound adjective. 
 Do not hyphenate third party when the adjective "third" modifies the noun 

"party." 

Correct 
Third-party software is reusable software, designed to improve the efficiency and 
quality of developing custom applications. 
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This is the third party she has thrown this summer. 



title caps 

Using "title caps" refers to following these guidelines for capitalization of titles: 

 Capitalize all nouns, verbs (including is and other forms of be), adverbs 
(including than and when), adjectives (including this and that), and 
pronouns (including its). 

 Capitalize the first and last words, regardless of their parts of speech ("The 
Text to Look For"). 

 Capitalize prepositions that are part of a verb phrase ("Backing Up Your 
Disk"). 

 Do not capitalize articles (a, an, and the) unless the article is the first word 
in the title. 

 Do not capitalize coordinate conjunctions (and, but, for, nor, or) unless the 
conjunction is the first word in the title. 

 Do not capitalize prepositions of four or fewer letters unless the preposition is 
the first word in the title. 

 Do not capitalize to in an infinitive phrase ("How to Format Your Hard Disk") 
unless to is the first word in the title. 

 Always capitalize the first word in a hyphenated word in a title. Capitalize the 
second word only if it is a noun or an adjective or is as important as the first 
word (State-Specific Lending Requirements). Do not capitalize the second 
word if it is another part of speech or a participle that modifies the first word 
(Applying Stage Make-up). 

unordered lists 

Lists that do not have a sequence 

Use the following bullet styles for unordered lists: 

 A solid circle for a first-level list 
 A solid square for a second-level list 

o An open circle for a third-level list 

URL 

An acronym that stands for uniform resource locator. An address for a resource on 
the Internet. A URL is used by Web browsers to locate Internet resources. It specifies 
the protocol to be used in opening the resource (such as http: for a World Wide Web 
page or ftp: for an FTP site), the name of the server on which the resource resides 
(such as //www.whitehouse.gov), and, optionally, the path to a resource (such as an 
HTML document or a file on that server). 

utilize, utilizing 

Do not use. Write use for utilize and using for utilizing. 

via 
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The word via means 



 By way of (in a geographical context, as in "I traveled to the Grand Canyon 
via Phoenix and Flagstaff, Arizona") 

 By means of (when specifying a method of delivery) 

Correct 
Send the mortgage documents to the title company via FedEx within 24 hours of 
signing. 

WebHelp 

 
An uncompiled form of HTML-based help that runs on a variety of browsers and 
platforms. WebHelp is a registered trademark of Adobe Systems Incorporated 
(formerly Macromedia, Inc.). 
 

Web, Webmaster, Web page, Web site 

 The word "Web" is always capitalized. 
 A Web page is referred to with two words.  
 A Web site is referred to with two words. 
 Although lowercase is used for job titles (except when they appear in 

headings and subheadings), use a capital "W" for Webmaster (one word). 
 Use the verbs open and close with a Web page. 

Correct 
Open the company Web page to find a current mailing address. 
The RefDesk.com Web site is very helpful to writers. 
Send an email message to the ADS Webmaster. 
Close the Web page before continuing. 
In Google, type the keywords Italian restaurant Orange County CA to search the 
Web for places to eat. 

who, whom 

 
Whom is the object of a verb; who is a pronoun. Do not use whom in place of 
who. 

Correct 
Custom Setup is for experienced users who want to alter the standard configuration. 
That is the person to whom they were referring. 
To whom am I speaking? 
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Incorrect 
Custom Setup is for experienced users whom want to alter the standard 
configuration. 
To who am I speaking? 



Information Designer QA Checklist 

Use to QA each book to be sent to IDD review 
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Page Header 

       

Is the header present and have the 
correct information? 

       

 
Breadcrumbs 

       

Do all links work, point to the correct 
topics, and match topic titles exactly? 

       

Does the heading start with About?        
Is the current topic link (and the 
word Summary) removed? 

       

Is the link to the Summary page (w/o 
the word Summary) included? 

       

If combined or combined-
nonviewable topic, are breadcrumb 
links to highest common book? 

       

 
Topic Heading 

       

Does the heading end with the word 
Summary? 

       

Is the first bulleted line after a 
sentence in Compressed style? 

       

Does the heading end with Process 
Flow? 

       

Does the heading start with a gerund 
(-ing word)? 

       

Is the heading in plural form, if 
possible? 

       

        
Summary Overview/Introduction 
Paragraphs 
Is there a summary, overview, or 
introduction? 

       

Are paragraphs in Normal style?        
Are bulleted lines in Compressed 
style? 

       

Is the Process Flow FYI (about 
procedure links) included? 

       

        
Summary Page - Topics Section 
Is the About page the first topic 
listed? 
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If a Business Policy is included, is it 
the second topic? 

       

If a Process Flow is included, is it the 
second topic (third if a Business 
Policy is included)? 

       

Does the Process Flow topic include 
the words Process Flow? 

       

Is the first topic link in Normal style 
and subsequent topic links in 
Compressed style?  

       

Do all links work, point to the correct 
topics, and match topic titles exactly? 

       

Do the topic titles match the TOC 
topic titles exactly? 

       

 
About Page - Rules and 
Guidelines 

       

Is the first line (sentence or bullet) in 
Normal style?  

       

Is the first bulleted line after a 
sentence in Compressed style 

       

Is the hierarchy of bulleted lists: ·● 
then ■ then o ? 

       

Do Rules contain words such as must 
or required, if possible? 

       

Do Guidelines contain words such as 
should, can, and might, if possible? 

       

Has the Rules or Guidelines section 
been deleted if no rules or guidelines 
are stated?  

       

 
Process Flow - Diagram 

       

Does the process flow begin with the 
standard arrow describing the 
triggering event? 
 

       

Do statements in the rectangular 
boxes begin with an active verb and 
first letter capitalized? 

       

Is the ending period omitted from the 
rectangular box statement? 

       

Is text in the decision shapes 
(diamonds) in question format? 

       

Are articles (a, an, the) omitted, if 
possible?  

       

Do all Procedures links work and 
point to the correct topics?  

       

Are all Yes and Nos within (not next 
to) arrow lines, if possible?  

       

Is a border around the diagram 
omitted? 

       

 
Procedures - Subheadings and 
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Role Name 
Does Heading 2 read Procedures 
(plural) if there is more than one set 
of numbered steps? 

       

Is the department capitalized and job 
title all lowercase in RoleName? 

       

Does the RoleName appear after 
Heading 2 and before Heading 3? 

       

Does Heading 3 (infinitive phrase) 
start with To and end with a colon? 

       

Is Heading 3 in singular form, and 
does it mirror/rephrase the topic 
heading, if possible? 

       

        
Procedure Steps 
Is the first step in Normal style?        
Are subsequent steps in Compressed 
style? 

       

Is the procedure numbered correctly 
(no missing step numbers/letters)? 

       

Do steps begin with an active verb, if 
possible? 

       

Is parallel sentence construction used 
in the steps? 

       

Is the hierarchy of numbered lists: 1, 
2, then a, b, then i, ii? 

       

Is the hierarchy of bulleted lists: Ÿ 
then § then o ? 

       

Is a bullet used rather than a number 
if a single step procedure?  

       

 
View/Hides 

       

Are view/hides in ViewHideDetails 
style? 

       

Do all view/hides open?        
Are all view/hide items in 
Compressed style? 

       

Are view/hide items indented 
properly? 
 

       

 
Images 

       

Are image links in ImageLink style?        
Do all image links open?        
Are images in Normal style?        
Do images appear in proper 
sequence? 

       

Are images linked to actions, if 
possible? 

       

Do red arrows on images point to the 
correct actions? 

       

Are red brackets used rather than 
multiple arrows, if possible? 
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Are hotspot pop-ups in the proper 
format (field name bold, left justified, 
and matches screen's field name 
exactly)? 

       

Do images have standard gray 
borders? 

       

Is nonpublic information on images 
blurred? 

       

        
Tables 
Does the table follow the template 
style? 

       

Is the table left justified with the 
corresponding text? 

       

Is the table text aligned correctly (left 
justified, top of cell)? 

       

Is the first line of text within a cell in 
Normal style? 

       

Are subsequent lines within a cell in 
Compressed style? 

       

        
See Also 
Is the See Also button present and 
working?  

       

Are all relevant topics (including 
combined) listed in See Also? 

       

Do See Also topic titles match TOC 
topic titles? 

       

 
Revision Date and History 

       

If a new topic, does Revision History 
read First published (new topic)? 

       

If not a new topic, does Revision 
History state the changes? 

       

        
DIN 
Does a two-character prefix identify 
the department? 

       

Does the Process Flow DIN end with 
1-1 (2-1 if second Process Flow, 3-1 
if third, etc.)? 

       

Does the DIN include CB (after the 
department prefix) if a combined 
topic? 

       

Does the DIN end with –NV if a 
nonviewable topic? 

       

 
 
General 

       

Is the topic free from spelling, 
grammar, punctuation, capitalization, 
and spacing errors? 

       

Is boldface type used for names of 
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screens, windows, pages, fields, 
buttons, menus, commands, user 
input, and Web sites? 
Are numbers between zero and nine 
spelled out (unless associated with 
dates, times, etc.) and in number 
format if 10 and over? 

       

Is the first letter capitalized in 
bulleted lines? 

       

Are FYIs and Importants (and 
subsequent colons) boldface? 

       

Are statements following FYI and 
Important statements in 
Compressed style? 

       

Do topic links appear in blue 
underlined text? 

       

Do all links work, point to the correct 
topics, and match topic titles exactly? 

       

Do linked topics open in the active 
window (Page Default) for topics 
within the project? 

       

Do linked topics open in a New 
Window with a TOC for topics outside 
the project? 

       

If linked topic is nonviewable, does 
topic open in a New Window without 
a TOC? 

       

Do glossary terms appear in green 
underlined text? 

       

Does the glossary pop-up 
window/text appear in proper format 
(blue banner, lowercase term unless 
proper, and description in sentence 
structure)? 

       

Do baggage files appear in blue 
underlined text? 

       

Do baggage files work and do links 
open in a New Window? 
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